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This course is part and parcel of the new reformed curriculum – the Outcome Base 
Education (OBE). Its learning outcomes are student centred and written in terms that allow 
them to be demonstrated, assessed and measured. 
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 UNIT 4: SPREADSHEET 2 

 
 

INTRODUCTION 

Excel is a spreadsheet application and is intended to be used to calculate and analyse 
numerical information such as household budgets, company finances, inventory, and more.  

Microsoft Excel 2010 the latest version which is out now. Worksheets contain numerical 
information presented in tabular row and column format with text that labels the data. They 
can also contain graphics and charts. It allows you to store, organise, and analyse numerical 
and text data. 

With Excel you can analyse, manage and share information quickly and easily to make more 
informed decisions. With the new user interface, rich data visualization, and PivotTable 
views, professional-looking charts are easier to create and use than ever before.  

But that is not a spreadsheet. However, if you bought Microsoft Excel and entered the same 
numbers into the software, you have a spreadsheet. The best part about a spreadsheet is - 
you do not have to do any adding up yourself. The program will add the numbers up for you.  
Spreadsheet are software programs consisting of a grid of data cells that can be used to 
organise, analyse and graphically represent data.  

A spreadsheet does not only add up, of course. It can do a whole lot more besides simple 
arithmetic. It can handle financial calculations, statistical information, and do complex 
trigonometry. And it can make a pretty graph for you. Though, a Spreadsheet is just a 
glorified calculator. The main point of using a spreadsheet is to do some number crunching. 
The software will puzzle out the answers to sums for you, and save you a lot of time and 
effort carrying numbers.  

Take note that activities are found at the end of every module lesson and summative 
exercises after every topic. All answers to activities are found after the summative exercises. 

The following icons are used in this module: 

   

  Student Aims      Student Activity 

 

  Time Frame      Note 

         

  Practical Student Activity  Answers to Learning Activities 
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Students Learning Outcomes 

 

On successful completion of this module, students will be able to: 

 demonstrate the ability to use advanced features and functions of spreadsheet 
tools to record and analyse data 

 apply appropriate techniques in formatting, manipulating and protection of data 

 apply advanced skills, techniques and strategies to creatively and methodically 
apply spreadsheets 

 demonstrate the use of formula 

 

 

        Time Frame 

This unit should be completed within 10 weeks. 

If you set an average of 3 hours per day, you should be able to complete the unit 
comfortably by the end of the assigned week. 

Try to do all the learning activities and compare your answers with the ones provided at the 
end of the unit. If you do not get a particular exercise right in the first attempt, you should 
not get discouraged but instead, go back and attempt it again. If you still do not get it right 
after several attempts then you should seek help from your friend or even your tutor. Do not 
pass any question without solving it first. 
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11.4.1     EXCEL BASICS REVIEW 

11.4.1.1 Excel Window 

Microsoft Excel is a spreadsheet program included in the Microsoft Office suite of 
applications. Spreadsheets present tables of values arranged in rows and columns that can 
be manipulated mathematically using both basic and complex arithmetic operations and 
functions. 

Common scenarios for using Excel include: 

 Accounting:  You can use the powerful calculation features of Excel in many financial 
 accounting statements—for example, a cash flow statement, income statement, or 
 profit and loss statement. 

 Budgeting:  Whether your needs are personal or business related, you can create any 
 type of budget in Excel—for example, a marketing budget plan, an event budget, or a 
 retirement budget. 

 Billing and Sales:  Excel is also useful for managing billing and sales data, and you can 
 easily create the forms that you need—for example, sales invoices, packing slips, or 
 purchase orders. 

 Reporting: You can create various types of reports in Excel that reflect your data 
 analysis or summarise your data—for example, reports that measure project 
 performance, show variance between projected and actual results, or reports that 
 you can use to forecast data.  

 Planning:  Excel is a great tool for creating professional plans or useful planners—for 
 example, a weekly class plan, a marketing research plan, a year-end tax plan, or 
 planners that help you organise weekly meals, parties, or vacations. 

 Tracking:  You can use Excel to keep track of data in a time sheet or list—for example, 
 a time sheet for tracking work, or an inventory list that keeps track of equipment. 

A cell in Excel is simply an individual container for data (like a box or pigeonhole). An array of 
cells is called a sheet or worksheet or Excel Window. Technically, a worksheet is a single 
document inside a workbook, but the terms workbook, worksheet or Excel Window and 
Spreadsheet are often used interchangeably. A Spreadsheet or worksheet holds information 
presented in tabular row and column format.  

 

 

 

 

 

cell 

The Excel Window 

http://www.webopedia.com/TERM/S/spreadsheet.html
http://www.webopedia.com/TERM/M/microsoft_office.html
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Parts of an Excel Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The parts of an Excel Window was discussed and identified in Unit 3 Lesson 1 in Grade 10 
Spreadsheet. 

1. Quick Access Toolbar is located above the Ribbon, and it lets you access common 
commands no matter which tabs you are on. By default, it shows the Save, Undo, and 
Repeat commands. 

2. Ribbons contain multiple tabs each with several groups of commands. 

3. Formula Bar displays information entered or being entered as you type-in the current or 
active cell. The contents of a cell can also be edited in the Formula Bar. 

4. Name Box shows the cell address of the current selection or active cell. 

5. Active Cell (Cell Address) is an intersection of a column and row. 

6. Sheet Tabs separate workbook into specific worksheets. A workbook defaults to three 
worksheets. A workbook must contain at least one  worksheet. 

7. Rows are represented by numbers that appear on the left and then run down the  Excel 
screen. 

8. Columns are represented by alphabetic characters in the gray boxes that run across the 
Excel screen. 

The Parts of an Excel Window 
 

Name Box 
Rows 

 
Excel Window 

Active Cell 

Sheet Tabs 

Formula Bar 
Columns 

 

Vertical Scroll Bar 

Ribbons 

Horizontal Scroll Bar 

Quick Access Toolbar 
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9. Vertical Scroll Bar is located along the right edge of the screen is used to move up or 
down of the Spreadsheet. 

10. Horizontal Scroll Bar is located at the bottom of the screen and is used to move left or 
right of the Spreadsheet. 

The cells in a Spreadsheet can contain three types of information. Excel will treat cells 
differently depending on the cell contents.  

• Texts are any names or labels that are required on the spreadsheet.  

• Numbers are all numerical values including dates or times, percentages and dollar 
values.  

• Formula is written in a cell to automatically calculate an answer.  

An Excel Workbook 

A workbook is a single file in Excel. Each new workbook contains three worksheets, which 
are named as Sheet1, Sheet2, Sheet3, and others. Worksheets are designed to display 
different data, example, and a company might use a worksheet for each sales branch, then a 
final worksheet which total all sales figures from each branch and displays a summary. 

Sheet tabs are displayed at the bottom of the screen. You can move from worksheet to 
worksheet by clicking on a sheet tab, as shown below.  

 A workbook is made up of three 
worksheets. 

 The worksheets are labeled Sheet1, 
Sheet2, and Sheet3. 

 Each Excel worksheet is made up of 
columns and rows. 

 In order to access a worksheet, click on the tab that says Sheet#. 

Some Keyboard Short Cuts in Excel 

If you have a large worksheet, navigating using this method becomes awkward and slow. 
Instead, you can press F5 and use the Go To dialogue box. In this dialogue box, a history of 
the Previous Go To, you have performed is displayed. You can either type in a new cell 
reference, or highlight a previously used one and then click enter. The selected cell becomes 
active. 

As well as using the arrow keys to move one cell at a time in the appropriate direction, you 
can use the following shortcuts below to navigate further fields. The descriptions may sound 
confusing, but if you spend a couple of minutes trying them out, you will easily become 
familiar with them. 

 

Click to move from worksheet to worksheet. 
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The Shortcut Keys of MS Excel: 

Ctrl + A - Select all contents of the 
worksheet. 

Ctrl + Tab - Move between Two or more 
open Excel files. 

Ctrl + B - Bold highlighted selection. Ctrl + F6 - Switch between open workbooks 
or windows. 

Ctrl + P - Bring up the print dialogue box to 
begin printing. 

Alt + =  -  Create a formula to sum all of the 
above cells 

Ctrl + F9 - Minimise current window. Ctrl + ' - Insert the value of the above cell 
into cell currently selected. 

Ctrl + Page up - Move between Excel work 
sheets in the same Excel document. 

Ctrl + Page down - Move between Excel 
work sheets in the same Excel document. 

Ctrl + Shift +!  -  Format number in comma 
format. 

Ctrl + Shift + $ - Format number in 
currency format. 

Ctrl + Shift + # - Format number in date 
format. 

Ctrl + Shift +; - Enter the current time. 

Shift + F3 - Open the Excel formula window. Ctrl +; - Enter the current date. 

Familiarising yourself with Excel Window will allow you to work easily; you can use it to 
organise your data into rows and columns. You can also use it to perform mathematical 
calculations quickly. And it is also a big help to navigate in an Excel Window. 

 

Student Activity 11.4.1.1 

A. Do the following instructions on how to navigate Excel. 

1. Open MS Excel, click the Start Button MS Excel icon. 

2. Click each of the three worksheet tabs—Sheet1, Sheet2 and Sheet3 to become 
familiar, moving from sheet to sheet in the workbook. 

3. From the starting cell which is A1 in Sheet1, use your mouse to go to C3. 

4. Open Sheet2 and make your active cell in D2. 

5. Again open Sheet3 and make your active cell in E5. 

6. Use the Page Up (PgUp) and Page Down (PgDn) keys to get used to scrolling in a 
worksheet. 
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7. Use the horizontal and vertical scrollbars to practice scrolling up, down, left, and 
right in the worksheet. 

B. Identify the Parts of an Excel Window. 

 

 

 

 

 

 

 

 

 

 

Write the answers on the blank spaces provided. 

1. ________________________________ 5. _______________________________ 

2. ________________________________ 6. _______________________________ 

3. ________________________________ 7. _______________________________ 

4. ________________________________ 8. _______________________________ 

 

 

 

 

 

 

 

 

 

3 

6 

5 

 

2 

8 

1 

7 

4 
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11.4.1.2 Customising Data Appearance with Advanced Formatting 

Customizing Data Appearance 

Excel is not a formatting program although it has similar features with other Office program 
when it comes to formatting.  Spreadsheet features like font colours and size, grid line 
inclusion or exclusion, and automatic rounding allow you to turn a functional worksheet into 
a document suitable for presentation.  

A.  Change the Font 
By default, Excel 2010 uses the 11-point Calibri font for cell 
entries, but you can change this to another font style of your 
choice for all new workbooks. Follow the steps below on how 
to change the font. 

1.  Select the cells you want to modify. 

2.  Click the drop-down arrow next to the font command on 
the Home tab. The font drop-down menu appears. 

3.  Move your mouse over the various fonts. A live preview of the font will appear in 
the worksheet.     

4.  Select the font you want to use. 

B.  Change the Font Size 
Excel 2010 uses the 11-point Calibri font for cell entries, but you can change this to 
another font size of your choice for all new workbooks. Follow the steps below on how 
to change the font size.  

1. Select the cells you want to modify.  

2. Click the drop-down arrow next to the font size command 
on the Home tab. The font size drop-down menu appears. 

3. Move your mouse over the various font sizes. A live 
preview of the font size will appear in the worksheet.  

4. Select the font size you want to use. 

 

C. Grow Font and Shrink Font  
You can also use the Grow Font and Shrink Font commands to change the size. 

 

 

 

Changing font size 

Changing font 
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D. Using the Bold, Italic, and Underline Commands 
You can bold, italicise and underline the fonts by using 
the following commands below. 

1. Select the cells or range of cells. 

2. Click the Bold, Italic and/or Underline button in 
located in the Home tab. 

3. You can also use the keyboard shortcut by doing step one and pressing Ctrl + B 
(Bold), Ctrl + I (Italics) and/or Ctrl + U (Underline). 

4. Tick the buttons again to remove the selection. 

E. Add a Border 
By using predefined border styles, you can quickly add a border around cells or ranges of 
cells. If predefined cell borders do not meet your needs, you can create a custom 
border. Follow the steps below on how to add a border. 

1.  Select the cells you want to modify. 

2.  Click the drop-down arrow next to the Borders 
command on the Home tab. The border drop-down 
menu appears.   

3. Select the border style you want to use. You can 
draw borders and change the line style and colour of 
borders with the Draw Borders tools at the bottom 
of the Borders drop-down menu. 

F.  Change the Font Colour 

You can change the colour of the text in cells and the cell's background colour. For the 
background colour, you can use a solid colour, or you can apply special effects, such as 
gradients, textures, and pictures. Follow the steps below on how to change the font 
colour. 

1.  Select the cells you want to modify. 

Grow Font 

Shrink Font 

The Grow Font and Shrink Font commands 

 

 
The Bold, Italic, and Underline 

commands 

 

2 

3 

Adding a border 
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2. Click the drop-down arrow next to the font colour command on the Home tab. The 
colour menu appears.   

3. Move your mouse over the various font colours. A live preview of the colour will 
appear in the worksheet. 

4.   Select the font colour you want to use. Your colour choices are not limited to the 
drop-down menu that appears. Select More Colours at the bottom of the menu to 
access additional colour options. 

G. Add a Fill Colour   

  

You can add shading to cells by filling them with solid colours or specific patterns. Follow 
the steps below on how to add a fill colour. 

1. Select the cells you want to modify. 

2. Click the drop-down arrow next to the fill 
colour command on the Home tab. The 
colour menu appears.    

3. Move your cursor over the various fill 
colours. A live preview of the colour will 
appear in the worksheet. 

G.  More Text-decoration Options 
More options available for text decoration in Formatting cells  Font Tab Effects cells as 
below: 

 Strike-through: It makes strikes the 
text in the centre vertically.   

 Super Script: It makes content to 
appear as super. 

 Sub Script: It makes content to 
appear as sub. 

 

 

Advance Formatting 
Excel provides many options for displaying numbers as percentages, currency, dates, and so 
on. If these built-in formats do not meet your needs, you can customise a built-in number 
format to create your own. To create a custom number format, you start by selecting one of 
the built-in number formats as a starting point.  

 

2 

3 

 

Effects 

 
 

2 

3 

Changing Font Colour 
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You can then change any one of the code sections of that format to create your own custom 
number format. A number format can have up to four sections of code, separated by 
semicolons. These code sections define the format for positive numbers, negative numbers, 
zero values, and text, in that order. 

A. Create a custom number format 
In Excel, you are not limited to using the built-in number formats.  You can define your 
own custom number formats to do things like display values as thousands or millions 
(like 23K or 95.3M), add leading zeros, display " - " for zero values, or make negative 
values red. This feature is very well documented in Excel's help system. Just search for 
"custom number format" and look for "create or delete a custom number format".  

Follow the steps below on how to create a custom number format. 

1. Open the workbook in which you want to create and store a custom number format. 

2. Type 12345 as a sample value we will use for formatting.  

3. On the Home tab, click the Dialogue Box Launcher next 
to Number.  The dialogue box will appear. 

4. In the Number tab, click Custom. 

5. Locate the #,##0.00 format in the list box. The number 
format that you select appears in the Type box above the Type list. 

6. Click OK. Observe that the cell now has a set format. 

7. Repeat steps 1-5 but this time add letter K to customize the selected number 
format.  

 

 

 

 

 

 

 

 

B. Delete a Custom Number Format 

An Excel file sometimes plays trick and has set the default style to currency. One way to 
reset this is to select the normal style in the list, and change this back to general all the 
format. Follow the steps below on how to delete a custom number format. 

5 

4 

7 

3 

The Format Cells Category 
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1. On the Home tab, click the Dialogue Box Launcher next to Number. 

2. In the Category box, click Custom. 

3. In the Type list, scroll down and locate the custom number format (K#,##0.00) that 
you want to created earlier. 

4. Click the custom format and choose Delete 

Conditional Formatting 

MS Excel 2010 Conditional Formatting  feature enables you to format a range of values so 
that values outside certain limits are automatically formatted. Follow the steps below on 
how to apply conditional formatting in Excel 2010. 

1. Select the cells you want to analyse.  

2. Click Home.  

3. Click Styles  Conditional Formatting.  

4. Explore the different options given. The format is applied to your cells as you scroll the 
mouse through it. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The Conditional Formatting 

2 

3 

4 
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Student Activity 11.4.1.2 

 

Follow the instructions below. 

1. Type the following text in a blank worksheet. 

 

 

 

 

 

 

 

2. Format Sheet1 cells by changing the fonts, applying borders, Fill Colours and alignment. 
Adjust column width as needed. 

3. Apply number formats in column E. Use the number format 

4. Save your workbook as Attendance. 
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11.4.1.3 Maintaining Format Consistency with Style 

Formatting worksheets can be one of the most time consuming tasks in Excel, particularly if 
you are forced to replicate the organisation's standard colours and font schemes. A style is 
simply a collection of formatting options, such as font size, cell colour and border style 
settings, saved with a sensible name and which can be applied to the cells quickly. Style can 
consist of settings for up to different attributes: 

 Font (type, size, and colour) 

 Borders  

 Alignment (vertical and   horizontal) 

 Number format 

 Pattern 

 Protection (locked and hidden) 

 

 

 

 

 

 

Add the Style Box Button to the Quick Access Toolbar  

Using styles is a fantastic way to save time when formatting a worksheet as you can apply a 
whole range of formatting options to cells with a couple of clicks of the mouse. Follow the 
steps below on how to add the Style Box button to the Quick Access Toolbar. 

1. Click File menu and choose Options. The Excel Options dialogue box appears. 

2. Click Quick Access Toolbar.   

3. Click the desired commands to be added to the Quick Access Toolbar 

4. Click Add. 

5. Click OK. 

 

 

Style attributes 

a b c d e e 
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3 

4 

 

 

 

 

 

 

 

 

 

 

 

Applying a Style to Cells 

 
Now let us see how styles are helpful. Suppose that you apply a particular style to some 
twenty cells scattered throughout your worksheet.  Later, you realise that these cells should 
have a font size of 12 pt. rather than 14 pt. Perform the steps below to apply styles to cells. 

1. Type MY STYLE in cell C3, select the cell you want to apply the style to. 

2. Select the cells that contain the text that you typed. 

3. In the Home tab, click Cell Styles located in the Styles group.  

4. The display is a live preview, that is, as you move your mouse over the style choices, the 
selected cell or range temporarily displays the style. When you see a style you like, click 
it to apply the style to the selection. 

 

 

 

 

 

 

 

 Cell Styles 

2 
3 

4 

5 
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Merge Styles 

Deleting Styles 

You cannot technically remove a style from a cell - every cell uses a style.  Each cell uses the 
Normal style by default.  To remove the formatting applied by a style you can simply set the 
cells back to using the Normal style.  

If you want to delete the styles that you have created, 
highlight the cell or cells to be deleted and click Home  
Styles then click Normal. 

Merging Style from Other Workbook 

When you create new cell styles in a workbook, you may 
want to make them available in other workbooks. You 
can copy the cell styles from that workbook to another 
workbook. Follow the steps below on how to merge style from another workbook. 

1. Open the workbook that contains the cell styles that you want to copy. 

2. Open the workbook that you want to copy the styles into. 

3. On the Home tab, in the Cell Styles group, click More button   . 

4. Scroll down and click Merge Styles.    

5. In the Merge Styles dialogue box, click the workbook that contains the styles that you 
want to copy, and then click OK.   

 

 

 

 

 

 

6. If both workbooks contain styles that have identical names, you must indicate whether 
you want to merge these styles by doing the following: 

  Click Yes, to replace the styles in the active workbook with the copied styles. 

  Click No, to keep the styles in the active workbook as they are. 

 

 

Normal Style 

Book1 

5 

4 
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Changing the column width  

If you are working in Page Layout view (View tab, Workbook Views group, Page Layout 
button), you can specify a column width or row height in inches. In this view, inches are the 
measurement unit by default, but you can change the measurement unit to centimeters or 
millimeters (On the File tab, click Options, and then click the Advanced category). Follow the 
steps below on how to set columns width and row height. 

A. Set a Column to a Specific Width 

On a worksheet, you can specify a column width of 0 (zero) to 255. This value represents 
the number of characters that can be displayed in a cell that is formatted with the 
standard font. The default column width is 8.43 characters. If a column has a width of 0 
(zero), the column is hidden. Follow the steps below to set the column width to a 
specific width. 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format.   

3. Under Cell Size, click Column Width. 

4. In the Column width box, type the value that you want. 

                                                          

                                                      

 

 

B. Change the column width to automatically fit the 
contents (AutoFit) 

AutoFit refers to automatically adjust the column width according 

to the cell that has the most content. Perform the steps below to 

change the column width to fit the content of the cell. 

1. Select the column or columns that you want to change. 

2. On the Home tab, in the Cells group, click Format.              

Cells Group 

2 

 

3 

4 

2 

3 

The AutoFit Column Width 

Note:  Excel asks Yes or No only once, regardless of the number of pairs of 
identical style names. And also, when you move or copy a worksheet from 
one workbook to another workbook, all the styles that are used on that 
worksheet are also copied to that workbook.  
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3. Under Cell Size, click AutoFit Column Width. 

C. Match the column width to another column 

You can also copy the width of the column/s and paste it using Paste Special. Follow the steps 

below to copy column width. 

1. Select a cell in the column that has the width that you want to use. 

2. On the Home tab, in the Clipboard group, click Copy or use the keyboard shortcut 
CTRL+C. 

3. Right-click a cell in the target column, point to Paste Special, 
and then click the Keep Source Columns Width button. 

D. Change the default width for all columns on a worksheet or workbook 

The value for the default column width indicates the average number of characters of 
the standard font that fit in a cell. You can specify a different number for the default 
column width for a worksheet or workbook. Follow the steps below to change the 
default column width of the worksheet or workbook. 

1. Click any of the worksheet tab. You can also 
change all worksheet in the workbook by right- 
clicking a sheet tab and then click Select All 
Sheets on the shortcut menu. 

2. On the Home tab, in the Cells group, click Format.    

3. Under Cell Size, click Default Width. 

4. In the Standard column width box, type a new measurement.  

 

 

 

 

 

 

E. Changing column width using the mouse 

Follow the steps below to change the column width using 
the mouse. 

1. Position the mouse over the boundary of the column 
header between two column and when your mouse 

3 

Worksheet  Tabs 

Drag to resize 

 

 

2 

3 

4 
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pointer changes shape, click-hold and drag the mouse until the column is the width 
that you want.    

2. To change the width of multiple columns, select the columns that you want to 
change, and then drag a boundary to the right of a selected column heading. 

3. To change the width of columns to fit the contents, select the 
column or columns that you want to change, and then double-click 
the boundary to the right of a selected column heading. 

4. To change the width of all columns on the worksheet, click the 
Select All button, and then drag the boundary of any column 
heading.  

Changing Row Height 

You can specify a row height of 0 (zero) to 409. This value represents the height 
measurement in points (1 point equals approximately 1/72 inch or 0.035 cm). The default 
row height is 12.75 points (approximately 1/6 inch or 0.4 cm). If a row has a height of 0 
(zero), the row is hidden. 

A. Set a row to a specific height 

Follow the following instruction to change row to a specific height. 

1. Select the row or rows that you want to change.     

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click Row Height. 

4. In the Row height box, type the value that you want. 

B. Change the row height to fit the contents (AutoFit) 

Perform the steps below to change row height to fit the contents. 

1. Select the row or rows that you want to change or you can drag to resize. 

2. On the Home tab, in the Cells group, click Format. 

3. Under Cell Size, click AutoFit Row Height. 

C. Change the height of rows by using the mouse. 

Follow the steps below to change row height using the mouse. 

1. To change the row height of one row, drag the boundary 
below the row heading until the row is the height that you 
want.    

2. To change the row height of multiple rows, select the rows 

 

 
Drag to resize 
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that you want to change, and then drag the boundary below one of the selected 
row headings. 

3. To change the row height for all rows on the worksheet, click the Select All button, 
and then drag the boundary below any row heading.    

4. To change the row height to fit the contents, double-click the boundary below the 
row heading. 

 

Student Activity 11.4.1.3 

A.  Add Format Painter Icon   to the Quick Access Toolbar. Identify the steps on 
how to add the Format Painter Icon. 

1.  ___________________________________________________________________ 

2. ___________________________________________________________________ 

3.  ___________________________________________________________________ 

4. ___________________________________________________________________ 

B. Follow the given instructions. 

1. Open Attendance workbook and remove styles previously applied to the table. 

2. Apply Styles to the heading (Row 1&2), use Heading1. 

3. Adjust the column width and row height to its desired column width. 

4. Use Accent1 for the body of the text. 

5. Save your work as Assignment 2. 
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11.4.1.4 Using Data Outlining 

Outlining data makes your data easier to view. If you have a list of data that you want to 
group and summarise, you can create an outline of up to eight levels, one for each group. 
Each inner level, represented by a higher number in the outline symbols displays detail data 
for the preceding outer level, represented by a lower number in the outline symbols. Use an 
outline to quickly display summary rows or columns, or to reveal the detail data for each 
group. You can create an outline of rows, an outline of columns, or an outline of both rows 
and columns. 

1. Open Attendance workbook. 

2. Sort all the males and females together. You can jump to the 

next lesson 11.4.1.5 Editing and Sorting Data or position cursor 

in any cell in column D and click Sort Ascending and Sort 

Descending button.  

4. In the Data tab Outline group, click 
Subtotal. A Subtotal dialogue box will 
appear and your table will be selected. 

5. We want to get the subtotal of 

outstanding fees of the male and female 

student. Click the dropdown list box and 

choose Sex.  

6. We will get the sum of the outstanding 

fees so we will not change Sum from the 

Use function drop down list. 

7. We will get the subtotal of outstanding 

fees. Make sure that the Outstanding 

column is ticked. 

8. Click OK. Your work should look like the 

example below. 

9. The table now displays the M Total , F 

Total and Grand Total.  

10. Tick 1, 2 or 3 to display the outline of 

calculations.  

11. You can also click the – and + sign placed at the right side which will collapse and expand 

the outline displayed on the screen. 

 

4 

5 

6 

7 

8 
12 
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12. Choose Remove All if you want to remove the outline. For this exercise to do click 
Remove All. 

Change Outline Setting 

Excel assumes that the summary rows in the data table are below their detailed data, and 
that the summary columns are to the right of the detailed data. If though, the summary rows 
are above and the summary columns are to the left, Excel can still build the outline 

In order to do that we just select the right arrow that is in the corner of the Outline area of 
the Data tab, in order for the appropriate dialog box to appear as we can see in the image 
below. 

1. Click the show Outline dialogue box 
icon. The outline dialogue box will 
appear. 

2. Tick/Untick the tick button as to what 
direction you want the data to be 

displayed. 

3. Tick/Untick Automatic styles 
if you want to apply format 
to your outline. 

4. Click Create not OK 
otherwise new setting will 
not be applied. 

5. Apply the Subtotal outline 
again to your table and see the difference. 

11 

4 

2 

3 4 

10

0 
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Group and Ungroup outline 

Unless it is needed, it is advisable to remove all settings and outlines you have previously set 
for your table. This will ensure that the new outline that you are creating will display the 
information correctly. 

1. Click Remove All in the Subtotal dialogue box. This will remove the outline you have 
previously set. 

2. Apply the type of setting you want to use on your new format. 

3. Sort column B using Sort AtoZ. This will alphabetically arrange the rows. 

4. Highlight the rows having the first letter of their lastname. In this example all the 
lastname that starts with B. 

5. Select Group from the Outline group. Click 
Group. A dialogue box will appear. 

6. Click Rows or Column from the radio buttons. 
For this exercise choose Rows and click OK. 

 

 

 

 

 

7. Observe that the next name on the list is immediately bolded. This means that the data 
above it is already grouped. 

8. Highlight the next group of lastname and 
repeat steps 6 and 7. Observe that the 
first group is immediately joined to the 
new group you have created. 

9. Click Ungroup from the Outline group. A 
dialogue box will appear. Select Row or 
Column that you want to ungroup.  

10. You must skip the next set of names so 
that it will not become a part of the 
previous outline.  

11. Highlight the next group of cells and repeat steps 6 and 7.  

12. Skip the next group of lastnames and highlight the last group there. 

5 

6 

8 

9 

5 
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13. Highlight to select the last part of the outline and repeat steps 6 and 7. 

 

 

 

 

 

 

 

14. Save your work as Attendance Outline. 

 

Student Activity 11.4.1.4 

Follow the instructions below. 

1. Use our sample data Attendance Outline to do your activity by creating an outline 
grouping using columns. 

2. Create an outline for Oustanding using columns.  

3.  Remove an outline. 

4.  Save your work as  Attendance OutlineColumns. 

 

 

 

 

 

 

 

 

 

 

10 

11 

12 

13 
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11.4.1.5 Editing Data and Sorting Data 

Sorting Data 

Sorting is a common task that allows you to change or customise the order of your 
spreadsheet data. For example, you could organize an office birthday list by employee, 
birthdate, or department, making it easier to find what you are looking for. Custom sorting 
takes it a step further, giving you the ability to sort multiple levels such as department first, 
then birthdate to group birthdates by department. 

Type the following data into your blank MS Excel. 

 

 

 

 

A. To sort in alphabetical order 
With more than 17 billion cells in a single worksheet, Excel 
2010 gives you the ability to work with an enormous amount 
of data. Arranging your data alphabetically, from smallest to 
largest, or using other criteria can help you find the 
information you are looking for more quickly. 

Follow the steps below to sort by alphabetical order. 

1. Make a cell in the column you want to sort by active. In this example, we will sort by 
Name so click any cell in the column. 

2. Select the Data tab, then locate the Sort and Filter group.    

3.  Click the ascending command  to Sort A to Z or the descending command  to 
Sort Z to A.  

B.  To sort in numerical order, follow the steps below. 

1. Make a cell in the column you want to sort by active. In this example, we will sort by 
Homeroom No. so click any cell in the column. 

2. From the Data tab, click the ascending command   to Sort Smallest to Largest or 

the descending command to Sort Largest to Smallest. 

3. The data in the spreadsheet will be organised numerically.  

 

 

 

Sort and Filter Group 

 



                   GR 11 ICT U4                                                                                                                                    SPREADSHEET 2 

 

32  

 

C.  To sort by date or time, follow the steps below. 
Follow the steps below to sort by date or time order. 

1. Select a cell in the Payment column you want to sort.    

2. From the Data tab, click the ascending   command to Sort Oldest to Newest or 

the descending command to Sort Newest to Oldest. 

3. The data in the spreadsheet will be organised by date or time.  

D. Custom sorting 
MS Excel 2010 worksheet has become quite large; using the Sort 
dialogue box to sort on multiple columns can make it easier to find the 
data you need. The Sort dialogue box lets you tell Excel what column 
to sort on next if two cells in the main sort column contain the same 
value or data. 

1. Make sure that the workbook is still open. 

2. Make any cell in the table active. 

3. From the Data tab, click the Sort command to open the Sort dialogue box. 
Observe that the entire table is automatically selected except the table header. 

4. Identify the column you want to Sort by clicking the drop-down arrow in the 
Column field. In this example, we will choose Size. Make sure Values is selected in 
the Sort On field. Click the drop-down arrow in the Order field, then choose A to 
Z.  

5. Click Add Level. A new level will appear. 

6. Identify Name as the column you want to sort next. Let Values remain in the Sort 
On. And Z to A as the Order. 

7. Click OK.  

 

 

 

 

 

 

 

Custom Sort 

3 

4 

6 7 

5 

Click to change 

the order of sort. 
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Your work should look like the example given: 

 

 

 

 

 

 

 

 

E. To change the sorting priority, follow the steps below. 

1. From the Data tab, click the Sort command to open the Custom Sort 
dialogue box. 

2. Select the level you want to reorder. 

3. Use the Move Up or Move Down arrows. The higher the level is on the 
list, the higher its priority.  

4. Click OK.  

5. Save your work as SortData. 

Editing Data 

To work with data on a worksheet, you first have to enter that data in the cells on the 
worksheet. Then, you might want to adjust the data so that it is visible, and display it just the 
way that you want. Editing data in MS Excel will enable the users to know various ways to  
change data in the cells in order to meet the user’s needs.  

Let us get our sample data from the MS Excel with a filename SortData. 

A. Overtype 
Over typing is one way of editing our data, just hold on to the mouse and place the 
cursor to the cell that you want to replace. Follow the steps below on how to overtype. 

1.   Click the left button of the mouse. 

2.   Type or replace the data inside the cell. 

B.  Formula Bar 
Follow the steps below on how to use the formula bar. 

To Sort from Smallest to Largest 

The Size column was arranged alphabetically (A-Z.). Observe that the Benson and 

Means both have the same size. Custom sorting allows you to further sort 

information. By adding Name as the next level, you can control how the 

information will be displayed. In this case we have Means name displayed before 

Benson because of the arrangement Z-A. 
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1.  Click your mouse to the cell where you need to edit. 

2.   Click your mouse to the formula bar, edit or replace the data by typing onto the 
 formula bar the word or data to be replaced. 

C.   Double Click 
Follow the step below on how to use the double click command. 

1. By double clicking the cell that you want to edit, you can also replace or edit your 
data by doing so. 

                   Student Activity 11.4.1.5 

       Follow the instructions below. 

1. Open your filename SortData.  

2. Insert the following the new column (T-Shirt Colour). Use the example below as guide. 

 

2. But before sorting your data, apply Text Hightlight Colour to column C for T-shirt 
Colour. 

3. Choose Name, Sort On (Values), Order (Z to A). 

4. Add Level by T-shirt Colour, Sort On (Cell Colour), Order (Dark Red and On Top). 

5. Add Level by Payment, Sort On (Values), Order (Newest to Oldest). 

6. Click OK. 

7. Save your work SortData2. 
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11.4.1.6 Chart Review 

Charts are used to display series of numeric data in a graphical format to make it easy to 
understand large quantities of data and the relationship between different series of data. 
MS Excel supports many types of charts to help you display data in ways that are meaningful 
to your audience.  

A chart has many elements. Some of these elements are displayed by default, others can be 
added as needed. You can change the display of the chart elements by moving them to other 
locations in the chart, resizing them, or by changing the format. You can also remove chart 
elements that you do not want to display. 

Types of Charts 

A. Column: Column chart shows data changes over a period of time or illustrates 
comparisons among items.  

B. Bar: A bar chart illustrates comparisons among individual items. 

C. Pie: A pie chart shows the size of items that make up a data series, proportional to the 
sum of the items. It always shows only one data series and is useful when you want to 
emphasize a significant element in the data.  

D. Line: A line chart shows trends in data at equal intervals. 

E. Area: An area chart emphasizes the magnitude of change over time.  

F. X Y Scatter: An XY (scatter) chart shows the relationships among the numerical values 
in several data series, or plots two groups of numbers as one series of XY coordinates. 

G. Stock: This chart type is most often used for stock price data, but can also be used for 
scientific data (for example, to indicate temperature changes).   

H. Surface: A surface chart is useful when you want to find optimum combinations 
between two sets of data. As in a topographic map, colours and patterns indicate areas 
that are in the same range of values. 

I. Doughnut: Like a pie chart, a doughnut chart shows the relationship of parts to a 
whole; however, it can contain more than one data series. 

J. Bubble : Data that is arranged in columns on a worksheet so that x values are listed in 
the first column and corresponding y values and bubble size values are listed in 
adjacent columns, can be plotted in a bubble chart.  

K. Radar: A radar chart compares the aggregate values of a number of data series 
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Create and Edit Chart 

A. Create a Chart 

When you create a chart or change an existing chart, you can select from a variety of 

chart types (such as a column chart or a pie chart) and their subtypes (such as a stacked 

column chart or a pie in 3-D chart). You can also create a combination chart by using 

more than one chart type in your chart. We will use Line chart as an example for our 

exercise. To create a line chart execute the following steps.  

1. Type the Following text: 

 

 

 

 

 

 

   I. Doughnut 

 

    J. Bubble 

 

   K. Radar 

 

              A. Column Chart 

 

   B. Bar Chart 

 

   C. Pie Chart 

 

 D.  Line Chart 

 

  E. Area Chart 

 

  F.  XY Scatter 

 

      G. Stock 

 

    H. Surface 
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2.  Select the range A1:D7.   

3.  On the Insert tab, in the Charts 
group, choose Line, and select 
Line with Markers. 

 

 

 

 

B. Change Chart Type 
In Microsoft Excel, you can represent numbers in a chart. On the Insert tab, you can 
choose from a variety of chart types, including column, line, pie, bar, area, and scatter. 
The basic procedure for creating a chart is the same no matter what type of chart you 
choose. As you change your data, your chart will automatically update. A colourful chart 
is ideal for presentations or for printing on a colour printer. But shades of grey are best 
for monochrome printing of charts.  

You can easily change to a different type of chart at any time. To change the chart type. 

1.  Select the chart you recently created. 

2.  On the Insert tab, in the Charts group, choose Column, and select Clustered 
Column. 

 

 

 

 

 

 

 

 

 

C. Switch Row/Column 
If you want the animals, displayed on the vertical axis, to be displayed on the horizontal 
axis instead, execute the following steps.   

1.  Select the chart you created.  

Selecting Clustered Columns 

 

Original 2D chart 

Chart changed 2D 

Column Result 

3 

 

2 
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2.  On the Design tab, click Switch Row/Column. Observe how the legend of the chart 
changes. Appearance of the data will depend on the type of chart you are using. 

 

 

 

 

Chart Component 

The typical chart (or graph) in Excel 2010 comprises several distinct parts, including the chart 
area, data series, axes, legend, plot area, gridlines, data markers, and more. The following 
list summarises the parts of a typical Excel chart, some of which appear in the illustration. 

 

A typical column chart containing a variety of standard chart components. 

 Chart area: Everything inside the chart window, including all parts of the chart (labels, 
axes, data markers, tick marks, and other elements listed here). 

 Data marker: A symbol on the chart that represents a single value in the worksheet. A 
data marker (or data point) may be a bar in a bar chart, a pie in a pie chart, or a line on 
a line chart. Data markers with the same shape or pattern represent a single data 
series in the chart. 

 Data series: A group of related values, such as all the values in a single row in the chart. 
A chart can have just one data series (shown in a single bar or line), but it usually has 
several. 

 

   

   

Click to switch the presentation of the data in the chart. 
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 Axis: A line that serves as a major reference for plotting data in a chart. In two-
dimensional charts there are two axes — the x-axis (horizontal/category) and the y-axis 
(vertical/value). In most two-dimensional charts (except bar charts), Excel plots 
categories (labels) along the x-axis and values (numbers) along the y-axis. Bar charts 
reverse the scheme, plotting values along the x-axis. Pie charts have no axes. Three-
dimensional charts have an x-axis, a y-axis, and a z-axis. The x- and y-axes delineate the 
horizontal surface of the chart. The z-axis is the vertical axis, showing the depth of the 
third dimension in the chart. 

 Tick mark: A small line intersecting an axis. A tick mark indicates a category, scale, or 
chart data series. A tick mark can have a label attached. 

 Plot area: The area where Excel plots your data, including the axes and all markers that 
represent data points. 

 Gridlines: Optional lines extending from the tick marks across the plot area, thus 
making it easier to view the data values represented by the tick marks. 

 Chart text: A label or title that you add to the chart. Attached text is a title or label 
linked to an axis such as the Chart Title, Vertical Axis Title, and Horizontal Axis Title that 
you cannot move independently of the chart. Unattached text is text that you add with 
the Text Box command button on the Insert tab of the Ribbon. 

 Legend: A key that identifies patterns, colours, or symbols associated with the markers 
of a chart data series. The legend shows the data series name corresponding to each 
data marker (such as the name of the blue columns in a column chart). 

A. Change the format of Chart Components 

The Chart Tools Format tab in Excel 2010 contains command buttons that make it easy 
to format particular chart elements after you select them. Excel gives you a choice of 
methods for selecting individual chart components. All chart components have shortcut 
menus attached to them. If you know that you want to choose a command from the 
shortcut menu as soon as you select a part of the chart, you can both select the object 
and open the shortcut menu by right-clicking the chart object. 

Follow the steps below on how to change the format of a selected chart element. 

1. Click anywhere in the chart. This displays the Chart Tools.  Three new tabs were 
added:  the Design and Format tabs.     

2. On the Format tab, in the Current Selection group, click the arrow next to the Chart 
Elements box, and then select the chart element that you want to format.  

3. On the Format tab, in the Current Selection group, click Format Selection. The 
dialogue box appears.  
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4. In the Format (Chart Element) dialogue box, click a category, and then select the 
formatting options that you want.  

5. Click Close to apply changes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2 

3 

The name of the dialogue box will be the name of the chart element 
you selected. Any changes you made in the dialogue box will be applied 
only to the selected element, 

 

 
You can undo multiple changes that you made to one dialogue box 
option as long as you did not make changes to another dialogue box 
option in between. You may want to move the dialogue box so that 
you can see both the chart and the dialogue box at the same time. 
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B. Change the shape style of a selected chart element 
You can change the format of chart elements by selecting the chart area, plot area, data 
series, axes, titles, data labels, or legend. You can use the Format (Chart Element) 
dialogue box to make formatting changes, or you can apply predefined or custom shape 
styles. You can also format the text in a chart element.  

Follow the steps below on how to change the shape style of a selected chart element. 

1. In a chart, click the chart element that you want to change or follow the steps 
discussed in the previous lesson on how to select chart element. 

 

2. To apply a predefined shape style, on the Format tab, in the Shape Styles group, click the 
style that you want.  

3. Click More button to display all available shape styles.  
 

 
 
 
 
 
 

4. To apply a different shape fill, click Shape Fill, and then do one of the following: 

a. Change the colour using Theme Colours or Standard Colours.  

b. To remove the colour from the selected chart element. Click No Fill.  

c. To use a fill colour that is not available under Theme Colours or Standard 
Colours. Click More Fill Colours. In the Colours dialogue box, specify the colour 
that you want to use on the Standard or Custom tab, and then click OK. Custom 
fill colours that you create are added under Recent Colours so that you can use 
them again. 

d. To fill the shape with a picture, click Picture. In the Insert Picture dialogue box. 
Click the picture that you want to use, and then click Insert.  

 

 

 

 

 

 

 

2 3 

a 

d 

b 

Colours palette will display 

More Fill Colours 
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5. To apply a different shape outline, click Shape Outline, and then do one of the 
following: 

a. To use a different outline colour, under Theme Colours or Standard Colours, 
click the colour that you want to use. 

b. To remove the outline colour from the selected chart element, click No Outline. 
If the selected element is a line, the line will no 
longer be visible on the chart. 

c. To use an outline colour that is not available under 
Theme Colours or Standard Colours, click More 
Outline Colours. In the Colours dialogue box, 
specify the colour that you want to use on the 
Standard or Custom tab, and then click OK. 
Custom outline colours that you create are added 
under Recent Colours so that you can use them 
again.  

d. To change the weight of a line or border, click 
Weight, and then click the line weight that you 
want to use. For additional line style or border 
style options, click More Lines, and then click the 
line style or border style options that you want to 
use.  

e. To use a dashed line or border, click Dashes, and 
then click the dash type that you want to use. For additional dash-type options, 
click More Lines, and then click the dash type that you want to use. 

f.   To add arrows to lines, click Arrows, and then click the arrow style that you 
want to use. You cannot use arrow styles for borders. For additional arrow style 
or border style options, click More Arrows, and then click the arrow setting 
that you want to use. 

 

 

 

C. Change the format of text in a selected chart 
element 

To format the text in chart elements, you can use 
regular text formatting options, or you can apply a 
WordArt format. 

1. Make sure that the chart you created is still 

Shape Outline drop-down 

list 

2 

3 

Note:   Available shape effects depend on the chart element that you 
selected. Pre-set, reflection, and bevel effects are not available for all chart 
elements. 
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open. 

2. Click the chart element that contains the text that you want to format.  

3. Right-click the text or select the text that you want to format and click the 
formatting options that you want on the Mini toolbar or  

On the Home tab, in the Font group, click the formatting buttons that you want to 
use. 

4. In a chart, click the chart element that contains the text that you want to change, or 
do the following to select the chart element from a list of chart elements:  

a. Make sure that the chart you created is 
still open. Click the chart element that 
contains the text that you want to format.  

b. On the Format tab, in the WordArt Styles 
group click the style that you want.  To see 
all available WordArt styles, click the More 

button.  

c. To apply a custom WordArt style, click Text Fill, Text Outline, or Text Effects, 
and then select the formatting options that you want.  

Student Activity 11.4.1.6 

 

A. Identify the Different Chart Lay Outs by writing the answers on the spaces provided 
after the pictures. 

 

 

 

1. __________________________________________________________________ 

2. __________________________________________________________________ 

3. __________________________________________________________________ 

4. __________________________________________________________________ 

5. __________________________________________________________________ 

1 
2 3 4 5 

6 7 

2 

3 
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6. __________________________________________________________________ 

7. __________________________________________________________________ 

                   

B. Change into different Lay out. 

1. Using our filename ChartType change the charts into different Layout. 

2. Highlight the whole cells, and select a chart (Cylinder). 

3. Use the Design tab and use the Switch Row/Column. 

4. Change the font colour to Green and the font style into Algerian size 8. 

 

Summative Activity 11.4.1 

A. Follow the given instructions. 

Type the following data into your blank MS Excel.  

A1       Name B1     Gender C1       Class D1    House Colour E1       Sports 

A2        Peter Leno B2      M C2         9-H D2     BLUE E2        Rugby 

A3        John Mose B3      M C3        10 –M D3     GREEN E3        Soccer 

A4        Junior Abesano B4      M C4         9-H D4     YELLOW E4        Soccer 

A5        Mary Ann Santos B5      F C5         10-H      D5     RED E5        Netball 

A6        Vaima Jonathan B6      F C6         9-H D6     RED E6        Netball 

A7        Ila Brown B7      M C7         10-M D7     BLUE E7        Soccer 

A8        Joseph Cays B8      M C8         10-M D8     BLUE E8        Soccer 

A9       Christopher Maino B9      M C9          9-H D9     GREEN E9        Soccer 

A10     Angeline Topal B10    F C10        9-H D10   RED E10      Netball 

A11     Sorella Moses B11    F C11        10-M D11   GREEN E11      Soccer 

1. Change Font styles for the titles (in row 1) into Bodoni MT Black, Font size 16, Font 
colour Red.  

2. Adjust the titles for the columns accordingly. 

3. Align all the titles in row 1 to the center. 
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4. Align columns B, C, D, E to the center. 

5. Change the colours of the text for Column D according to the given House Colours. 

6. Apply cell’s backgroung colour for Column E. 

 For Soccer apply Light Green.  

 For Rugby apply Orange. 

 For Netball apply Pink. 

7. Save it with a filename My_Activity1. 

 Check and compare your answers after this Learning Activities. 

8. Highlight row 1 of the titles and apply font styles.   

9. Using the ribbon or toolbar, select the style Heading 1 to the selected cells. 

10. Sort the Gender in column B, wherein M for Gender will be on top, followed by sorting 
the names in column A alphabetically. 

11. Save it with a filename My_Activity2. 

 Check and compare your answers after this Learning Activities. 

12. Now, try to Delete Level from the styles and sort your data by Sports, Netball should 
be On Top and followed by their Class sorting it by descending order. 

13.  Save it with a filename My_Activity3. 

Check and compare your answers after these Activities. 

B.  Follow the instructions below for data outlining 

1. Open your file My_Activity2, in Column F type the following data. 

 F1 Allowance 

 F2 300 

 F3 200 

 F4 180 

 F5 150 

F6 230 

F7 240 
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F8 180 

F9 200 

F10 250 

F11 270 

2. Modify the title F1 by following the corresponding title and adjust the column width. 

3. Center the data in Column F. 

4. Insert row in between cells A7 and A8.  

5. Change the cell theme colour for cell E8 to No Fill.   

6. Type Total for Males in cell A8, bold the fonts and change the font size to 14. 

7. Type Total for Females in cell A13, bold the fonts and change the font size to 14. 

8. Compute for the Total in cells F8 for males and F13 for females. 

9. Format column E by clicking the Number format from the Home tab using two decimal 
places. 

10. Highlight cells A1 to F8, and create Outline of Rows. 

 Save it with a filename My_Activity4. 

Check and compare your answers after these Summative Activities. 

C.  Follow the instructions below for creating a chart. 

1. Using your file My_Activity4, highlight cells A2 to A13 and F2 to F13. 

2. Insert Chart by selecting 3-D Column Chart (Cylinder). 

3. From the Chart Layouts, select the first layout to create a title of your chart. 

4. Double click the title from the chart and type Student’s Allowance. 

5. Click the inside of your chart and change the Chart Styles in your desired layout. 

6. Save your file My_Activity5. 
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Answers to Student Activities 11.4.1 

Student Activity 11.4.1.1 

A. 

 

 

 

 

B. 

1. Ribbons   5. Rows 

2. Columns   6. Sheet Tabs 

3. Formula Bar   7. Horizontal Scroll Bar 

4. Active Cell   8.  Vertical Scroll Bar 

Student Activity 11.4.1.2 

The example given is just an example of what your text could look like. However the number 
format used in column E must be exactly like the example given below. 

 

 

 

 

 

 

 

 

 

Student Activity 11.4.1.3  

A. Steps to include Paint Icon to the Quick Access Toolbar 

1. Open a blank worksheet. 

Step 3 Screen shot Step 4 Screen shot 

S 

Step 5 Screen shot 
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2. Click File Menu and choose Options. 

3. Click Quick Access Toolbar 

4. Select Paint Icon to be added to the Quick Access Toolbar. 

5. Click OK. 

 

 

 

 

 

 

 

B.  

Your work should look like the example below.  

 

 

 

 

 

 

 

The following formats were done using the following option. 

1. Open Assignment workbook. 

2. Highlight cells and click Cell Styles 

3. Choose Normal.  

4. Highlight A1 to E2 and apply Heading 1 format. 

5. Highlight cells A3 to E12 and apply Accent1 format.  

3 

4 



                   GR 11 ICT M4                                                                                                                                SPREADSHEET 2 

 

 49 

 

5. Save your work as Assignment 2. 

 

 

 

 

 

 

 

 

 

  

Student Activity 11.4.1.4 

 

 

2 3 

4  

5 
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Student Activity 11.4.1.5 

 

 

Student Activity 11.4.1.6  

A 

1. Column 

2. Line 

3. Pie 

4. Bar 

5. Area 

6. Scatter 

7. Other Charts 
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B 

                                    

 

 

 

 

Answers to Summative Activities 11.4.1 

 

 

A. 

 

 

 

 

 

 

 

B. 

 

 

C. 

   

After modifying the cell, the cell fonts and font styles 
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Data Outlining 

 

Creating a Chart 

 

 

 

 

 

 

 

 

 
Chart result after selecting the names and the allowance 
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11.4.2 Working with Multiple Worksheets, Workbooks and Integrating 
with Other Applications 

11.4.2.1 3-D Formula 

It is helpful to be able to create a single formula that calculates data gathered from multiple 
worksheets. These types of formulas are called 3-D formulas. They calculate information 
from multiple worksheets and show the result in a selected formula cell. 

When you use 3-D formulas, you must also expand your knowledge of formula syntax. You 
will be using additional punctuation marks when you write these formulas in order to tell 
Excel specifically which cells from which worksheet you will be using. The additional 
punctuation marks you will need to know are: 

1.  ! – used to separate the sheet name from the cell reference. 

2.  $ - used to denote an absolute value. 

3.  : - used to separate sheet names in ranged 3-D formulas. 

4.  , - used to separate individual sheet/cell references from each other. 

Preparing your worksheets. 

6. Open a blank workbook, create the following worksheet.  

7. Rename your worksheet POM, LAE, GOROKA and XYZ Co.  

 

 

 

 

 

 

 

 

 

A. Simple 3D Formula Syntax 
The best way to learn how 3-D formula works is to look at some examples. Follow the 
steps below to create a 3D formula 

1. In cell B2 in XYZ Co worksheet, type “=“ sign  

Sheet 1 - POM Sheet 2 - LAE 

Sheet 3 - Goroka Sheet 4 – XYZ Co 
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2. Click POM worksheet. Notice that the formula bar now displays “=pom!”.  

3. Click cell B2 in POM worksheet. The formula bar now display =pom!B2. Pom refers 
to the name of the worksheet and ! separates the name of the worksheet from the 
cell address. 

4. Type the plus sign (+). Your formula now displays =pom!B2+ 

5. Repeat steps 2 to 4 for Lae and Goroka worksheets. Press Enter after you have 
linked the last worksheet. Your formula should display =pom!B2+lae!B2+goroka!B2 

6. Repeat the same steps to get the total for Tablet and Laptop or copy the formula 
down. 

Let us use another way of using 3D formula: 

1. In cell C2 of XYZ Co worksheet, type “=sum(”. Sum is a function command that 
means to add. Using the Sum function eliminates the need to use (+) sign and means 
to add up everything inside the bracket(). 

2. Repeat the steps indicated above but instead of using plus sign (+) we will replace it 
with a comma (,) symbol.  

3. Your formula should display “=sum(pom!C2,lae!C2,Goroka!C2)”. the comma (,) 
separates the group of cells you want to add from another group. 

4. Repeat the same steps to get the total for Tablet and Laptop or copy the formula 
down. 

B. Creating 3-D Range References 
When referencing 3-D ranges in formulas, you use the colon (:) to separate the names of 
the first and last sheets in the range, followed by a single cell range reference. The cell 
reference given is then used as the selected cell range through all of the worksheets 
listed. So in the above example, you are adding cell B2 from Sheet1, Sheet2, and Sheet3. 

In 3-D ranges the given cell range cannot change from one sheet to another. Otherwise 
it is just another 3-D formula, and you should use one of the other two alternate 
syntaxes available. 

Follow the steps below to create a 3D range reference. 

1. In cell D2 of XYZ Co worksheet, type “=sum(”. 

2. Click pom worksheet and select cell D2. Your formula bar will display “=sum(pom!” 

3. Erase the symbol (!) and replace (:). The colon symbol (:) means a range.  

4. Click the last worksheet Goroka. Your formula will now display =sum(pom:goroka! 
In this case the range from the first worksheet to the last worksheet will be added 
and the exclamation mark is automatically added. 
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5. Click the cell that you want to add. In this example, click D2. 

6. Save your work as XYZ Co Sales 

The importance of using the 3-D formula is to create a single formula that calculates data 
gathered from multiple worksheets. It calculates information from multiple worksheets and 
show the result in a selected formula cell. Punctuation marks needed are (!) – used to 
separate the sheet name from the cell reference, ($) - used to denote an absolute value, (:) - 
used to separate sheet names in ranged 3-D formulas, (,) - used to separate individual 
sheet/cell references from each other. 

             Student Activity 11.4.2.1 

 

1. Open XYZ Co Sales workbook. 

2. Add Total column to all worksheet in column F.  

3. Calculate for the total sales for all the quarters for each item. 

4. In the XYZ Co workbook, calculate for the total of the 4th quarter for all the three 
branches. Use simple 3D formula to do your calculation in the XYZ Co workbook. 

5. Add another Total column in XYZ Co workbook. Use 3D range to do your calculations. 

6. Save your work XYZ Co Sales 3D. 
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11.4.2.2 Using Range Names 

Types of names 

Assign a descriptive name to a cell or range in Excel 2010 to help make formulas in your 
worksheets much easier to understand and maintain. Range names make it easier for you to 
remember the purpose of a formula, rather than using obscure cell references. 

For example, the formula =SUM(Qtr2Sales) is much more simplified than =SUM(C5:C12). In 
this example, you would assign the name Qtr2Sales to the range C5:C12 in the worksheet. 
There are several types of names that you can create and use. 

 Defined name is a name that represents a cell, range of cells, formula, or constant 
value. You can create your own defined name, and Microsoft Excel sometimes creates a 
defined name for you, such as when you set a print area. 

 

 

 

 

 

 Table name is a name for an Excel table, which is a collection of data about a particular 
subject that is stored in records (rows) and fields (columns). Excel creates a default Excel 
table name of Table1, Table2, and so on, each time that you insert an Excel table, but 
you can change a table's name to make it more meaningful. 

Example Type  Example with no name  Example with a name  

Reference =SUM(C20:C30) =SUM(FirstQuarterSales) 

Constant =PRODUCT(A5,8.3) =PRODUCT(Price,WASalesTax) 

Formula =SUM(VLOOKUP(A1,B1:F20,5,FALSE), -G5) =SUM(Inventory_Level,-Order_Amt) 

Table C4:G36 =TopSales06 

 

Naming cells 
A named cell represents a cell, range of cells, formula, or constant value. You can create your 
own defined name or Microsoft Excel sometimes creates a defined name for you, such as 
when you set a print area. By using names, you can make your formulas much easier to 
understand and maintain. You can define a name for a cell range, function, constant, or 
table. Once you adopt the practice of using names in your workbook, you can easily update, 
audit, and manage these names. 

Format tab 
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To name a cell or range, follow these steps:  

1. Open our filename SortData, select the cells (C1 to C5) or 
cell range that you want to name. You can also select 
noncontiguous cells (press Ctrl as you select each cell or 
range). 

2. On the Formulas tab, click Define Name in the Defined 
Names group. The New Name dialogue box displays the 
suggested name Sales because it is the name written in 
the column title.  

3. In the Name text box, type up to a 255-
character name for the range.  

Range names are not case-sensitive; 
however, range names must follow these 
conventions:   

 The first character must be a letter, an 
underscore, or a backslash. 

 No spaces are allowed in a range name. 

 The range name should not be the same as a cell address. For example, you cannot 
name a range U2 or UB40, but BLINK182 and ABBA are just fine.  

4. Now, let change the data Sales with March_Sales and click OK. 

5. Select cells C7:C9 and give it a range name of April_Sales. 

6. Click OK.  

Selecting a named range 
Alternatively, you can enter a range name into the Name box located at the left end of the 
Formula bar and press Enter to create the name. 

Follow the steps below on how to use a named range. 

1. To use a named cell or range, click the down arrow in the 
Name box at the left end of the Formula bar.     

2. Select the range name you want to access, and Excel highlights 
the named cells. You also can use range names with the Go To 
dialogue box, to make it easier to locate specific areas of a 
worksheet.  

3. Press F5 to display the Go To dialogue box, select the range name you want to jump to, 
and click OK. Or Select Home Tab, go to Editing Group, click on Find and Select. A drop 
down arrow will display Go to. 

1 

5 

1 

3 

4 
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Use range names in formula 
You can insert range names into formulas just like they were normal cell references. Be 
careful using named multi-cell ranges, though. Remember to use functions that require a 
range instead of a single cell reference — such as MAX, SUM, or AVERAGE — or else you will 
get an error message. To use range names in formulas: 

1. In cell C6, type “=sum(March_Sales)” and press Enter. The total of all the cells in the 
group. 

2. In cell C10, type “sum(April_Sales)”. The range name is automatically converted to 
uppercase. 

3. In cell C11, type “=March_Sales+April_Sales” and press Enter. Observe that a #Value 
error appears. This is because a named range only works with function commands. 

4. Change the formula to “=sum(March_Sales,April_Sales) and press Enter. 

5. Save changes to your work. 

 

                Student Activity 11.4.2.2 

1. From your filename SortData type the following data in cell: 

  D1 Latest Sales  D2   5020  D3  4500 

D4 3011    D5   1294  D7   3332 

D8 999    D9   4565 

2. Use the Range Name for cell D1:D5 to March and D7:D9 to April. 

3. Use range names to solve for the SUM for March Total, April Total, and East Total for 
column D. 

4. Save your work as Name Range Formula. 

 

 

 

 

 

 

 



                   GR 11 ICT M4                                                                                                                                SPREADSHEET 2 

 

 59 

 

11.4.2.3 Combining Worksheets and Data from Different Workbooks 

Over the course of business, you may find yourself with copious Excel files that you want to 
combine into a single workbook to make life a little easier. Excel 2010 allows you to copy or 
move individual worksheets from one workbook into another without hassle. No cutting and 
pasting needed. There is no upward limit on the number of sheets you can merge into a 
single workbook; you can have as many as your computer's memory can handle.  

We usually maintain the data in multiple worksheets to check the data for each instance and 
to view them individually but it would be great to merge all the data from different 
worksheets in Excel Spreadsheet to analyse it. Consolidate feature in Excel 2010, allows you 
to pull-each record from the worksheet into one master worksheet, which adds-up all the 
data from Spreadsheets. Through Consolidation, you can summarise data from multiple 
sheets into one designated master sheet. By assembling data into master sheet, you can 
modify or aggregate it under one window. 

Summarising data from one or more source areas by consolidating it and creating a 
consolidation table. These source areas can be on the same worksheet as the consolidation 
table, on different sheets in the same workbook, or in different workbooks. When you 
consolidate the source data, you apply a summary function, such as the SUM function, to 
create the summary data. 

To create a summary data:  

 1.  Create another new workbook, by clicking File tab, New Create. 

2.   Type the following data into your blank worksheets. Save your work. Use the filename 
written in the text box.  

 

 

 

 

 

 

 

 

7. Open all the four workbooks and make the blank workbook active. Consolidation will 
not work if any or all of the books are closed 

8. In the blank workbook, click the Data 

9. Choose Consolidate. This will display the consolidate dialogue box. 

Save as: Consolidate1 Save as: Consolidate2 

Save as: Consolidate 3  A blank workbook which you will save later 
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10. Make Consolidate1 workbook active and highlight cells A1:D4. The name of range of 
cells immediately appears in the Reference list box.  

11. Click Add. A reference address will be displayed in the All Reference list box. Click Delete if your 
make a mistake. 

 

 

 

 

 

 

 

 

12. Repeat steps 9 to 10 to for Consolidate2 and Consolidate3 workbook. 

13. Tick Top row and Left column to place the labels in the workbook you will use to 
consolidate all the three workbooks: Consolidate1, Consolidate2, Consolidate3. 

14. Tick Create links to source date. To update your workbook every time there are changes 
to any of the workbooks. 

 

 

 

 

 

 

As you can see, the worksheets are not identical. However, the beauty of the 
Consolidate feature is that it can easily sum, count, average, this data by looking at the 
labels. This is a lot easier than creating formulas, open all three workbooks. 

15. Click OK. The result will now display the outline of the consolidated workbook.  

 

 

7 

8 

9 

10 

13 

 

 14 
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13. Save your work with the filename Consolidate4. 

 

              Student Activity 11.4.2.3 

     

Type and follow the instructions below. 

1. Type the following data into your blank MS Excel Worksheet. (Sheet1) 

     A1:Letter    B1:Code Number    C1:More Number 

       A2:M      B2:50                   C2:62 

       A3:H       B3:99                    C3:11 

       A4:G       B4:86                    C4:68 

       A5:C       B5:18                    C5:31 

       A6:K       B6:67                    C6: 9 

2.    Save your work with the filename Consolidate5. 

3.    Go to File tab, Click New. Type the following data into your blank worksheet. (Sheet1) 

Note: if you do not check the Top row and Left column, Excel sums all cells 
that have the same position. For example, cell B2 (in Consolidate1.xls) + cell 
B2 (in Consolidate2.xls) + cell B2 (in Consolidate3.xls). Because our 
worksheets are not identical, we want Excel to sum cells that have the same 
labels. If you check Create links to source data, Excel creates a link to your 
source data (your consolidated data will be updated if your source data 
changes) and creates an outline. 

 

 

14 

http://www.excel-easy.com/examples/outlining-data.html
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        A1:Letter          B1:Code Number    C1:More Number 

        A2:M                 B2:38              C2:17 

       A3:H                  B3:53              C3:25 

        A4:G                    B4:48                   C4:18 

        A5:C                    B5:59                   C5:53 

        A6:K          B6:78                   C6:97 

3.    Save your work with the filename Consolidate6.  

4.    Go to File tab, Click New.  

5.    Go to Data tab, and Click Consolidate. 

6.    Save your answers with the filename Consolidate7. 
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11.4.2.4 Linking Information from Different Worksheets and Workbooks 

Microsoft Excel provides the ability for one worksheet to link to data in another worksheet. 
This is a great productivity tool.  A link formula that dynamically pulls in data from a cell in 
another worksheet. The worksheet can be in the same workbook or a different workbook. 
The destination worksheet contains the formula, and it receives data from a cell in the 
source worksheet. Anytime the cell value in the source worksheet changes, the cell 
containing the link formula will be updated as well, the next time it is opened. This is just 
one of many reasons the Excel software program is so powerful 

Link cells from different worksheet 
When you link a cell in Excel to a cell from another worksheet, the cell that contains the link 
shows the same data as the cell from the other worksheet. The cell that contains the link is 
called a dependent cell. The cell in another worksheet that contains data to which the link 
refers is called a precedent cell. Dependent cells automatically change if the precedent cells 
change.  

1. Open XYZ Co Sales 3D workbook. 

2. Add a new row to Total Quarter to all of the branch worksheets (POM, Lae and Goroka).  

3. Get the total of all the total quarter sales for the entire branch and all the quarters. Use 
the example below as guide. 

 

 

 

 

 

4. Create a new worksheet by clicking the 
Insert Worksheet button at the bottom 
of the worksheet tabs. 

 Note that in Office 2016, the Insert 

Worksheet button will appear as     + 

5. Type the following information in the new 
workbook. 

6. In cell B2 type “=” and click the Pom 
worksheet.  

7. Click cell F5. Your formula bar now displays 
“=pom!F5”. the formula displayed is in syntax to your previous lesson on 3D reference. 

4 
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8. Repeat the steps 6 to 7 for Lae and Goroka branch. 

9. Save your work as XYZ Co Sales Link. 

Link multiple cells from another workbook 
You can link multiple cells from another. Follow the steps below to link information from 
different worksheet/workbook by using an array function, which allows you to link a range 
of cells using one formula. Follow the steps below to 
link multiple cells ranges. 

1. Open POM, LAE and Goroka worksheets.  

2. Open a new blank workbook. In Sheet1 type the 
following information. 

3. Make cell B2 active and type “=sum(” inside the 
cell.  

4. Click POM worksheet and select cells F2        F4 .  

5. Your formula bar should display the example below.  

 

6. Press Enter. 

 

7. Complete the table by following steps 2 to 6. 

 

 

 

POM Worksheet 

The result after linking POM, LAE and Goroka 
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8. Save your work as XYZ Co Link2. 

 

               Student Activity 11.4.2.4 

      Type and follow the steps. 

1. Open XYZ Co Link2 and  POM, LAE, Goroka workbooks. 

2. Open a blank workbook.  

3. Type the following data. 

 

4.  Link the Total for each items accordingly. 
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11.4.2.5 Importing Data 

If you have data from an alternative source, you may be able to import it into Excel 2010 
instead of having to re-enter all the information again.  Depending on the type of data you 
would like to import, you can select from a number of options.  We will look at one of the 
most common import types – a text file. 

You can open a text file that you created in another program as an Excel workbook by using 
the Open command. Opening a text file in Excel does not change the format of the file — 
you can see this in the Excel title bar, where the name of the file retains the text file name 
extension (for example, .txt or .csv). Before we begin, type the following text in MS Word. 

1. Type the following data into your blank MS Word. 

2. Click File  Save As. The dialogue box appears. 

3. In the File name box, type Monthly Bills. 

8. Save As dialogue box, click the drop down list and select Plain 
Text (*.txt). This will save your document as a Plain Text file.  

 

 

 

 

 

 

 

 

 

Import a text file to MS Excel 
You can import data from a text file into an existing worksheet as an external data range. 
Follow the steps on how to Import a text file. 

1. Open a blank MS Excel workbook. 

2. Click the cell where you want to put the data from 
the text file. 

2.    On the Data tab, in the Get External Data group, 
click From Text. The Import Data dialogue box will 

3 

4 

Note: If you have an existing MS Word document that you want to 

Import you must first save it as a text file. To do this, Click File  Open 

 Select MS Word file  Save As Plain Text  OK. 

 

To get External Data 
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appear. 

3.  Locate and double-click the text file that you want to import.  

4.   Follow the instructions in the Text 

Import Wizard. Click Help  on 
any page of the Text Import 
Wizard for more information 
about using the wizard. When you 
are done with the steps in the 
wizard, click Finish to complete 
the import operation.  

5.  The Import Data dialogue box will 
appear.  Under Where do you 
want to put the data?, do one of 
the following:   

 To return the data to the location that you selected, click Existing worksheet or New 
Worksheet if you want to save it another worksheet. 

 Click OK. Excel puts the external data range in the 
location that you specify. 

 

 

              Student Activity 11.4.2.5 

Type and follow the steps. 

1.   Type the following data below into your blank MS Word.   

January  2000 

February  6000 

March   8000 

April    10000 

May   10000 

June   2000 

2. Import data from Monthly Bills. 

3. Transfer data in column C1. 

4. Save your data with the filename MonthlyBills2. 

To Import Data 
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11.4.2.6 Exporting Data 

Sometimes we need to export workbook’s data to Comma delimited (CSV) files. We need to 
send a CSV file of the Excel data to other users or to import a CSV file of the Excel data in 
other programs.  

By default, the Excel workbook will be saved in the format of .xlsx. If you need to export data 
of active worksheet to a CSV file, you can use the Save As command with the following 
steps. You can convert an Excel worksheet to a text by using the Save As command.  

Follow the steps in Exporting data. 

1. Open Consolidate4 workbook.  

2. Click the File  Save As type box, choose the text file format for the worksheet.  

3. Click Comma delimited (CSV) 

 

 

3.  Browse to the location where you want to save the new text file, and then Click Save. 

4.  A dialogue box appears, reminding you that the current worksheet will be saved to the 
new file. If you are certain that the current worksheet is the one that you want to save 
as a text file, click OK. You can save other worksheets as separate text files by repeating 
this procedure for each worksheet. 

5.  A second dialogue box appears that your worksheet may contain features that are not 
supported by text file formats. If you are interested only in saving the worksheet data 
into the new text file, click OK. If you are unsure and would like to know more about 
which Excel features are not supported by text file formats, click Help for more 
information. 

Comma delimited (CSV) 
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To export data (creating a .csv file) you can only do it on the worksheet that you are 
working on. If the other worksheets are blank, you should not get a warning message. If 
you have other data that you also want to export, you will have to go to each sheet and 
create a new .csv file for that worksheet. You need to give it a different name.  It just 
appears that your file type is set to create a .csv file. Once you switch it to .xls or .xlsx 
(depending upon your version of Excel) it should stay that way until you select a 
different file type. 

               Student Activity 11.4.2.6 

 

Lists down the steps on how to export data. 

1.__________________________________________________________________________ 

___________________________________________________________________________ 

2.__________________________________________________________________________ 

___________________________________________________________________________ 

3.__________________________________________________________________________ 

___________________________________________________________________________ 

4.__________________________________________________________________________ 

___________________________________________________________________________ 

5.__________________________________________________________________________ 

___________________________________________________________________________ 
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Summative Activities 11.4.2 

A. 

Type and follow the instructions below. 

1. Type the data into your new blank worksheet.  In Cell, 

A1          List of Grocery Items for the Month of January 

A2          Rice B2         20 kgs. C2            80.00 

A3          Flour B3         6 packs C3            55.00 

A4            Cooking Oil B4         6 bottles C4             124.00 

A5            Milk B5         10 Boxes C5             200.00 

A6            Shampoo B6         5 bottles C6             90.00 

A7            Soap B7         6 boxes C7             14.00 

A8            Tissues B8         20 rolls C8             80.00 

A9            Cookies B9         6 packs C9             60.00 

2. Save this file in MS Excel My_Activity6. 

3. Make a new blank workbook and type this data. In Cell,  

A1           List of Grocery Items for the Month of February. 

A2           Rice B2          30 kgs. C2      170.00 

A3           Flour B3          7 packs C3      70.00 

A4           Cooking Oil B4          10 bottles C4      220.00 

A5           Milk B5          10 Boxes C5      220.00 

A6           Shampoo B6          4 bottles C6      85.00 

A7           Soap B7          9 boxes C7      24.00 

A8           Tissues B8          40 rolls C8      160.00 

A9           Cookies B9         10 packs C9      100.00 

4. Save this file in MS Excel My_Activity7. 

5. Use two decimal number format for Column C for the two workbooks. 
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6. Have your active worksheet in filename My_Activity6, place your answers in sheet2 
and use the 3-D formula to compute for the Total for (Rice, Flour and Cooking Oil), for 
My_Activity6 and My_Activity7. 

7. Type the title in cell A1, My Total for Rice, Flour and Cooking Oil. 

8. Type Rice in cell A4, Flour in A5 and Cooking Oil in A6. 

9. Solve for the Total for the two workbooks using the 3-D formula. 

B. 

10. Define columns in the two workbooks defining it as Price. 

C. 

11. Solve for the Grand Total for column C in My_Activity6 and My_Activity7. 

12. From My_Activity6 Sheet1, link (Rice, Flour and Cooking Oil) to Sheet2.  

D.   

13. Get your file MonthlyBills to Import data in My_Activity6. 
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  Answers to Student Activities 11.4.2 

  Student Activity 11.4.2.1 

POM 

 

LAE 

 

GOROKA 

 

XYZ CO. 

 

 



                   GR 11 ICT M4                                                                                                                                SPREADSHEET 2 

 

 73 

 

Student Activity 11.4.2.2 

           

           

Student Activity 11.4.2.3 

 

Student Activity 11.4.2.4 

 

 

 

 

 

The result with the Totals 
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Student Activity 11.4.2.5 

 

 

Student Activity 11.4.2.6 

1. Click the File tab, and then click Save As.  

2.  In the Save As dialogue box type box, choose the text file format for the worksheet. 

3. Browse to the location where you want to save the new text file, and then Click Save. 

4. Click OK. (If you are certain that the current worksheets is the one that you want to 
save as a text file). 

5. Click OK.) If you are unsure and would like to know more about which Excel features 
are not supported by text file formats), or Click Help for more information. 

 

 Answers to Summative Activities 11.4.2 

A. 

     

                         

B.  

 

 

           

After Importing data from MonthlyBills file 

 

After using the 3-D formula for the two workbooks 

 

C 

My_Activity6 My_Activity7 
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C.   

 

 

 

 

 

 

 

 

 
 

The result after Linking 

 

The result after importing data
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11.4.3 Creating PivotTables and Analysing Data 
 

11.4.3.1 Creating a PivotTable 

A pivot table is a special type of summary table that is unique to Excel. Pivot tables are great 
for summarising values in a table because they do their magic without making you create 
formulas to perform the calculations. Pivot tables also let you play around with the 
arrangement of the summarized data. It is this capability of changing the arrangement of the 
summarised data on the fly simply by rotating row and column headings that gives the pivot 
table its name. Follow the steps in creating a PivotTable. 

1. Type the following text. Save your work Light Inventory. 

 

 

 

2. Position the cursor anywhere in the table. 

3. Click the Pivot Table located in in the Insert tab of the Tables group.  

4. Click PivotTable in the drop-down menu. 

 

 

 

 

 

 

 

5. Excel opens the Create PivotTable dialogue box. 

Note: You can also open the worksheet that contains the table you want to 
summarised by pivot table and select any cell in the table. Ensure that the 
table has no blank rows or columns and that each column has a header.  

 

2 

3 

4 
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6. All the table data is selected as indicated by a marquee around the cell range. If 
necessary, adjust the range in the Table/Range text box under the Select a Table or 
Range option button.  

7. Click OK. Excel creates the new pivot table in a new worksheet. 

 

 

 

 

 

 

 

 

 

 

 

8. Your screen will display the Pivot Table on the left side and the Pivot Table List on the 
right side. 

 

              

 

 

 

 

 

 

 

               

Pivot Table Pivot Table Field 

List 

Note: By default, Excel builds the pivot table on a new worksheet it adds 
to the workbook. If you want the pivot table to appear on the same 
worksheet. Click the Existing Worksheet option button and then indicate 
the location of the first cell of the new table in the Location text box. 
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Excel adds a blank grid for the new pivot table and displays a PivotTable Field List task 
pane on the right side of the worksheet area. The PivotTable Field List task pane is 
divided into two areas: the Choose Fields to Add to Report list box with the names of all 
the fields in the source data for the PivotTable and an area divided into four drop zones 
(Report Filter, Column Labels, Row Labels, and Values) at the bottom. 

Report Filter: This area contains the fields tha enable you 
to page through the data summaries shown in the actual 
pivot table. You do this by filtering out sets of data which 
act as the filters for the report. So, for example, if you 
designate the Year Field from a table as a Report Filter, 
you can display data summaries in the pivot table for 
individual years or for all years represented in the table. 

Column Labels: This area contains the fields that 
determine the arrangement of data shown in the columns 
of the pivot table. 

Row Labels: This area contains the fields that determine 
the arrangement of data shown in the rows of the pivot 
table. 

Values: This area contains the fields that determine which 
data are presented in the cells of the PivotTable — they 
are the values that are summarised in its last column (total 
by default). 

To complete the pivot table, assign the fields in the PivotTable 
Field List task pane to the various parts of the table.  

1. Tick Item Code and Illumination. This will create a Pivot Table in the worksheet. Click 
the tick box again to remove the selection or 

You can also drag the field name in the drop zone. Choose from Report filter, column 
labels, row labels and values. 

2. As soon as you create a new pivot table (or select the cell of an existing table in 
worksheet), Excel displays the Options tab of the PivotTable Tools contextual tab.  

 

 

 

3. Among the many groups on this tab, you find the Show/Hide group that contains the 
following useful command buttons: 

2 

3 
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 Field List to hide and redisplay the PivotTable Field List task pane on the right side 
of the Worksheet area. 

 +/- Buttons to hide and redisplay the expand (+) and collapse (-) buttons in front 
of particular Column Fields or Row Fields that enable you to temporarily remove 
and then redisplay their particular summarised values in the pivot table. 

 Field Headers to hide and redisplay the fields assigned to the Column Labels and 
Row Labels in the PivotTable.    

4. If you want to clear a pivot table and start over, use the Clear control, on the Options 
tab of the PivotTable Tools Ribbon. Click, Clear, then choose "Clear All" 

 

 

 

 

 

Student Activity 11.4.3.1 

Follow the steps. 

1. Make sure that the Light Inventory workbook is still open.  

2. Click Sheet1 or the work sheet containing the table you typed. 

3. Create a new Pivot Table containing the Item Code, Quantity and Stock. 

4. Your work should look like the example below. 

 

 

 

 

 

5. Save your work as Light Inventory Activity. 
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11.4.3.2 Updating a PivotTable 

Excel PivotTables provide a powerful tool you can use to analyse your data. Whenever you 
change the information in your source data table, you will need to update the PivotTable. 
There is no need to recreate the table, instead you simply select a cell in the PivotTable and 
then select Refresh Data from the Data menu, or click on the Refresh Data tool on the 
PivotTable toolbar. 

Updating changes is simple enough, but there is probably an additional step you will take if 
you have added records to your data table. If you have added information at the end of the 
data table, either manually or using a data form, you need to redefine the data range used 
to create the PivotTable. 

By default, PivotTables are not refreshed automatically, but you can specify that the 
PivotTable is automatically refreshed when you open the workbook that contains the 
PivotTable 

A. Refresh 
 If you change any of the text or numbers in your data set, you need to refresh the 
 pivot table.  Follow the steps on how to Refresh, open your file name Light Inventory.  

1. Make sure that the worksheet containing the table is 
the active worksheet. 

2. Insert a new column called Damaged between column 
Sold and Stock Field. Add the following data. 

3. Select the worksheet that contains your pivot table. 
The Options tab will appear.   

4. Right click on the mouse and click on Refresh.  

 

 

 

 

5. Observe the Pivot Table Field list will now display 
the new field (Damaged) you recently added to 
your table. 

 
 
 
 

Insert and type Damaged 
column 

i 

4 

5 
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Refresh PivotTable data manually 
Follow the steps below on how to refresh pivot table data manually. 

1. Click anywhere in the PivotTable report. This displays the PivotTable Tools, adding an 
Options and a Design tab. 

2. Let us change the data in cell F2 to 40. 

3. To update the information to match the data source, click the Refresh button, or press 
ALT+F5.    

a. You can also right-click the PivotTable, and then click Refresh. 

4. To refresh all PivotTables in the workbook, click the Refresh button arrow, and then 
click Refresh All.  

 

 

 

 

 
B. View the refresh status or cancel the refresh 

After starting a refresh, you can review the status or cancel it at any time. 

On the Options tab, in the Data group, click the Refresh button arrow, and then click 
Refresh Status to view the status or Cancel Refresh to stop refreshing. 

C. Refresh PivotTable data automatically when opening the workbook 
         Follow the steps below on how to refresh pivot table data automatically when opening 

 a workbook. 

1. Click anywhere in the PivotTable report. 

  This displays the PivotTable Tools, adding an Options and a Design tab.  

2. On the Options tab, in the PivotTable group, click Options. 

 In the PivotTable Options dialogue box, on the Data tab, select the Refresh data  when 
opening the file check box. 

Any changes you make to the data set are not automatically picked up by the pivot table. 
Refresh the pivot table or change the data source to update the pivot table with the applied 
changes. Each time you refresh the PivotTable data, you will see the most recent version of 
the data, including changes that were made to the data since it was last refreshed. 

 

Note: If you experience display or formatting changes when you refresh 
the PivotTable report, make sure that the AutoFit column width on 
update and Preserve cell formatting on update check boxes are selected 
on the Layout & Format tab in the PivotTable Options dialogue box 
(PivotTable Tools, Options tab, PivotTable group, Options command). 
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Student Activity 11.4.3.2 

 
A.  List down the steps on how to update a PivotTable. 
 

1.__________________________________________________________________________ 

2.__________________________________________________________________________ 

3.__________________________________________________________________________  

             

  

 

B.  Type and follow the steps.  

1. Open Light Inventory workbook.  

2.  Create a Pivot table showing the Item Code, Description, Price and Stock. Take a screen 
shot of your pivot table. 

3.  Paste you screen shot in a blank document. 

4. Insert a new column called Supplier between Description and Wattage. For now this 
column will remain blank.  

5.  Apply Refresh to update the PivotTable.  

6. Take a screen shot of your revised Pivot Table Field List after you apply Refresh.  

7.  Paste the copy of your screen shot together with the first screen shot 

8.  Save changes to your Light Inventory workbook. 

9. Save your document as Light Inventory Screenshot. 
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11.4.3.3 Modifying a Calculated Field in a PivotTable 

In a PivotTable, you can create a new field that performs a calculation on the sum of other 
pivot fields. PivotTable, being the most celebrated feature of Excel, includes multitude of 
options to manipulate the data in desired way. Once PivotTable is created from the source 
data, you can add fields and items without modifying source data, which comes in handy for 
doing quick calculations. In this post we will demonstrate adding a calculated field in Pivot 
table. Follow the steps in modifying a calculated field in a PivotTable. 

1. Let us type our new data into our blank MS Excel. 

In Cells,   

A1 Region  B1 Month C1 Sales 

 A2 South  B2 May  C2 8677 

 A3 South  B3 Apr  C3 450 

 A4 North  B4 Apr  C4 1500 

 A5 South  B5 May  C5 3802 

 A6 East   B6 Mar  C6 2741 

 A7 North  B7 Apr  C7 9291 

 A8 West   B8 May  C8 5477 

 A9 East   B9 May  C9 5416 

 A10 East   B10 Apr  C10 9136 

2. Create a PivotTable containing all Region, Month and Sales 
fields. 

Now in PivotTable, we need to insert a new field without inserting field in data source which 
will show the 2% commission. 

3.  In PivotTable Tools Options tab 
locate the Calculation group 

4. Under Fields, Items, and Sets 
options, click Calculated Fields. 

 

 

 
 

Pivot Table 

3 

4 

http://www.addictivetips.com/microsoft-office/create-calculated-fields-in-access-2010/
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4. It will bring up Insert Calculated Field dialogue box. Enter an appropriate name of 
calculated field and formula for evaluating calculating field as shown below. 

  

 

 

 

 

 

 

 

 

5. Click OK. This will add a Sum of Commission field in Pivot table and the Pivot Table 
Field List will add a new field name.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Commission 2% 

=(Sales*2%) 

Result after calculating the percentage 

 

Note:  In the Insert Calculated Field dialogue box, do not forget to click the 
Insert Field box to select the appropriate field for your Formula 
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6. Save your work with a filename PivotTable Commission. 

       

Student Activity 11.4.3.3 

A.  

Write the steps to create a Pivot Table. 

1. _______________________________________________________________________ 

2. _______________________________________________________________________ 

3. _______________________________________________________________________ 

4. _______________________________________________________________________ 

5. _______________________________________________________________________ 

6. _______________________________________________________________________ 

7. _______________________________________________________________________ 

8. _______________________________________________________________________ 

B. 

1.  Open Light Inventory workbook. 

2. Create a Pivot table using the fields Item Code, Description and Price. 

3.  Change the Price (K) field header of your table to Price. Having a value enclosed in 
parenthesis () signifies that the content of the parenthesis is part of the formula. 

4. Click Refresh to apply changes to your Pivot table. 

3. Calculate for the K5 increase in price of all the products. The name of the Calculated 
field is Price Change and a formula must be created to calculate for the price change 
increase. 

3. Save your work as Light Inventory Price Change. 
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11.4.3.4 Creating a Chart from a PivotTable – Exploring What IF Table 

Scenarios are part of a suite of commands called what-if analysis tools. When you use 
scenarios, you are doing what-if analysis. 

What-if analysis is the process of changing the values in cells to see how those changes will 
affect the outcome of formulas on the worksheet. You can use scenarios to create and save 
different sets of values and switch between them. You can also create a scenario summary 
report, which combines all the scenarios on one worksheet. For example, you can create 
several different budget scenarios that compare various possible income levels and 
expenses, and then create a report that lets you compare the scenarios side-by-side. 

Kinds of What-If Analysis     

1. Scenarios 

2. Data tables  

3. Goal Seek  

 

 

Scenarios and data tables take sets of input values and project forward to determine 
possible results. Goal seek differs from scenarios and data tables in that it takes a result and 
projects backwards to determine possible input values that produce that result.  

What-If Analysis in Excel allows you to try out different values (scenarios) for formulas. The 
following example helps you master what-if analysis quickly and easily. 

Assume you own a book store and have 100 books in storage. You sell a certain % for the 
highest price of 50 and a certain % for the lower price of 20.  

1. Type the following data into your blank worksheet.  

 

 

 

 

 

 

2. In cell D10, type the following formula: =(C7*D7)+(C8*D8). This will calculate the sales of books 
at 60% profit. 

 

The Scenario Manager 
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3. Save your work as Profit Analysis. 

Creating Different Scenarios 

Study this situation: What if you sell 70% for the highest price? And what if you sell 80% for the 
highest price? Or 90%, or even 100%?  

Each different percentage is a different scenario. You can use the Scenario Manager to create these 
scenarios. 

What-if analysis enables you to easily compare the results of different scenarios. 

1. Make sure that the Profit Analysis workbook is still open. 

2. On the Data tab, click What-If Analysis and select Scenario Manager from the list. 

 

 

 

 

 

 

3. Add a scenario by clicking on Add. 

4. Type 60% highest in the Scenario Name. 

5. Click the Changing cells window and select cell C4 (% 
sold for the highest price). This will display the cell 
inside. 

6. Click OK. A dialogue box will appear. 

 

 

 

 

 

 

 

   

The Scenario Manager dialogue box appears. 

 

To add a Scenario 

3 

4 

5 

6 
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 The Add Scenario dialogue box consists of four parts: 

a. Scenario Name: You can give any name for this Scenario name field. Given 
name should be something meaningful. 

b. Changing Cells: These are the input cells for the scenario. You can enter the cell 
addresses directly or point to them. If you have been given names for the cells, 
type the name. Nonadjacent cells are allowed for this field. If you are required 
to point multiple cells, press CTRL key in your keyboard while you click on the 
cells. Not every scenario will use the same set of changing cells. Different 
scenario can use different changing cells. The number of changing cells is not 
unlimited for a scenario; it is limited to 32. 

c.   Comment: By default, Excel shows the name of the person who created the 
scenario and the date when it was created. But you can change this text, add 
new text to it, or delete it completely. 

d.   Protection: The two Protection options are preventing changes and hiding a 
scenario. These two are in effect only when you protect the worksheet and 
choose the Scenario option in the Protect Sheet dialogue box. When you are 
protecting a scenario, it will prevent anyone from modifying it; a hidden 
scenario does not appear in the Scenario Manager dialogue box. 

7.  In the dialogue box, enter the corresponding value 0.6 and Click on OK again. 

 

 

 

 

 

 

8.  Next, add 4 other scenarios (70%, 80%, 90% and 100%). You can do this clicking Add. 

9.  Repeat steps 4-7 to change the scenarios but still using cell C4 as cell reference. 

 

 

 

 

 

 

The Scenario Values The Scenario Values 
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10.  Finally, your Scenario Manager should be consistent with the picture below: 

 

 

 

 

 

 

 

 

 

 

 

Scenario Summary 

To easily compare the results of these scenarios, execute 
the following steps. 

1.  Click the Summary button in the Scenario Manager. 

2.  Next, select cell D10 (total profit) for the result cell 
and click on OK. 

Replace with 70% highest, 80% highest, 

90% highest and 100% highest. 

Use the same cell address for all 4 

scenarios. 

To be change to 0.7, 

0.8, 0.9 and 100 

The Scenario Manager 

The Scenario Summary 

Note:  To see the result of a scenario, select the scenario and click on the 
Show button. Excel will change the value of cell C4 accordingly for you to 
see the corresponding result on the sheet. 
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Therefore if you sell 70% for the highest price, you obtain a total profit of $4100, if you 
sell 80% for the highest price, you obtain a total profit of $4400, etc.  

3.   Save your work as Scenario Summary Exercise. 

               Student Activity 11.4.3.4 

 

1. Change the data in the cells that was encircled and see what happen to your Scenario 
Summary. 

 

 

 

 

 

 

 

 

 

 

The Result after the Scenario Summary 
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11.4.3.5 Creating a Chart from a PivotTable – Using Scenarios 

For a different view of the Scenario data, you can create a pivot table report: Follow the 
steps in creating a chart from a PivotTable – using scenarios. 

 

  

Use the file Scenario Summary Exercise for your pivot table. 

1. On the Ribbon's Data tab, click What-If Analysis. 

2. Click the drop down arrow, and click Scenario Manager.  

 

 

 

 

 

 

3. Click the Summary button. 

4. In the Scenario Summary dialogue box, for Report type, select Scenario PivotTable 
Report.   

5. Press the Tab key, to move to the Result cells box. 

6. On the worksheet, click on cell D10.This is the Profit cell, and it 
changes, based on the sales and expense amounts.  

7. Click the OK button. 

8. A Scenario PivotTable sheet is added to the workbook. 

              

 

The Scenario Summary 

A Scenario of a PivotTable sheet 

The What-If Analysis Tab 

 Note:  Delete this report after printing it, and create a new Summary 
when necessary. 
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9. By clicking Styles from the Home tab you can choose different styles for your table, try 
to choose any design from the templates. 

 

 

 

 

 

 

 

 

 

 

To View the Scenario PivotTable Report  
Follow the steps on how to view the scenario pivot table report. 

1. Select the Scenario PivotTable worksheet   

2. To rearrange the data, drag the field buttons to a different area of the Pivot Table. For 
example, drag the Dept,$B$3:$B$4 button from cell A4 (row area) to cell B3 (column 
area).   

There is no option for formatting the Scenario PivotTable Report when you create it. 
You can change the formatting in the completed pivot table, by selecting a different 
PivotTable Style.  

Creating a chart from a PivotTable – using Scenario 
Follow the steps for creating a chart from a PivotTable – using scenario. 

1. Highlight the cells to create a chart from a table. 

 

The different design templates 

To create a chart from a table 

http://www.contextures.com/xlScenario02.html#Top
http://www.contextures.com/xlScenario02.html#Top
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2. Click the Insert tab from the Ribbon and select Chart Column 2-D. 

 

 

3. Click Enter, save it by the filename Pivot Chart Exercise. 

    

  

Student Activity 11.4.3.5 

 

Follow the steps. Use the file Pivot Chart Exercise. 

1. Change this chart into different charts. 

 

a. Select the Bar Chart, Clustered Bar in 3-D. 

b. Select the Line Chart, Line with markers. 

The Insert Tab and the Column Chart 

The result after selecting the column 
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11.4.3.6 Creating a Chart from a PivotTable – Implementing Problem Solving 

A PivotChart can help you make sense of this data. While a PivotChart shows data series, 
categories, and chart axes the same way a standard chart does, it also gives you interactive 
filtering controls right on the chart so you can quickly analyse a subset of your data. 

As soon you create a pivot chart, Excel displays these items in the worksheet: 

PivotChart using the type of chart you selected that you can move and resize as needed 
(officially known as an embedded chart). 

PivotChart Tools contextual tab divided into four tabs and these are: Design, Layout, Format, 
and Analyse. Each with its own set of buttons for customising and refining the pivot chart. 

The command buttons on the Design, Layout, and Format tabs attached to the PivotChart 
Tools contextual tab make it easy to further format and customise your pivot chart: 

 Design tab: Use these buttons to select a new chart style for your pivot chart or even a 
brand new chart type. 

 Layout tab: Use these buttons to further refine your pivot chart by adding chart titles, 
text boxes, and gridlines. 

 Format tab: Use these buttons to refine the look of any graphics you have added to the 
chart as well as select a new background color for your chart.  

Follow the steps in creating a chart from a pivot table. 

1. Get your file PivotTable Commission. 

 

 

2. Solve for the Commission which is the 2% for column D. 

3. Use Pivot Table to solve for the Commission 2%. (Refer to your previous lesson on 
11.4.3.3). 

The PivotTable Commission 
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4. Create a Chart from the Pivot Table Tools, on Insert tab; choose Bar Chart for your 
Pivot table. 

5. Save your file PivotTable2. 

 

 

Student Activity 11.4.3.6 

 

Use the data from the file PivotTable2. 

1. Change the chart type of the chart created from the data of the file Pivot Table2. 

2. Change the chart layouts and its chart styles. 

Try at least two to charts and its layouts and styles.   

 a. Column Chart, Clustered Cone 

 b. Other Charts, Exploded Doughnut 

 

The Bar Chart output 

PivotTable result for 2% Commission. 
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Summative Activities 11.4.3 

A. 

1. Type the following data into your blank MS Excel. 

 

2. Click the $ sign. 

3. Solve for the Profit by subtracting the Sales to Expenses. 

4. Apply double lines to your answer for the Profit. 

5. Create a Scenario Summary. 

6. Use B6 for your Result Cells for Scenario Summary Report Type. 

7. From Scenario Manager, click Add and have these following data to enter (Finance, 
2400000 and Marketing, 2000000). 

8.  Click Summary. 

B. 

Make a Bar Chart from the given PivotTable using Scenario. 
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  Answers to Student Activities 11.4.3 

Student Activity 11.4.3.1 

The following tasks were done to perform the exercise. 

1. Select the worksheet containing the table you have typed. 

2. Click Insert tab Pivot Table  Pivot Table. The dialogue box appears. 

3. The table range is selected. Click OK. 

4. In the Pivot Table Field List, click  Item Code, Quantity and Stock 

5. Your work should look like the example on the next page. 

 

 

 

 

 

 

Student Activity 11.4.3.2 

A. 

1.  Column Labels - This area contains the fields that determine the arrangement of data 
 shown in the columns of the pivot table. 

2.  Report Filter - This area contains the fields that enable you to page through the data 
 summaries shown in the actual pivot table by filtering out sets of data — they act as 
 the filters for the report.  

3. Row Labels - This area contains the fields that determine the arrangement of data 
 shown in the rows of the pivot table. 

4. Values - This area contains the fields that determine which data are presented in the 
 cells of the pivot table — they are the values that are summarised in its last column 
 (total by default). 

B. 

Open Light Inventory Screenshot document. Your work Pivot Table Field List should look like 
the example below. 

4 

5 
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Student Activity 11.4.3.3 

1. Create a Pivot Table. To to this click Insert  Pivot Table  Create Pivot table dialogue 
box  OK  Tick the fields in the Pivot Field List: Item Code, Description and Price (K) 

2. Click Refresh after you changed the field Price (K) to Price. 

3. Create a Calculated Field. In the Options tab, click Fields, Items and Sets Calculated 
Field. The dialogue box will appear. 

4. The Name of the field you created may be different but you formula will look like the 
example given. 

 

 

 

6. Click OK. A new field will be added in your Pivot Table and Pivot Table Field List. 

 

 

 

 

 

 

 

Pivot Table Field List before the 
Supplier column was added. 

Pivot Table Field List after the 
Supplier column was added. 

Pivot Table Pivot Table Field List 
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7. Save your work as Light Inventory Price Change. 

Student Activity 11.4.3.4  

 

 

 

Student Activity 11.4.3.5 

 

 

 

 

 

The chart for Clustered Bar in 3-D 

The chart for Line with markers 
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Student Activity 11.4.3.6 

a. 

 

 

b. 

 

 

 

   Answers to Summative Activities 11.4.3 

A. 

 

 

 

Column Chart, Clustered Cone 

Other Charts, Exploded Doughnut 
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B. 
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11.4.4 Using Advanced Functions and Protecting and Auditing Forms and Templates 

11.4.4.1 Using the Financial Functions 

The Excel financial functions have been made available to execute a variety of financial 
calculations, including calculations of yield, investment valuations, interest rates, internal 
rate of return, asset depreciation, and payments. These financial functions can be, however, 
classified into different categories so as to enable you to meet on the required function. 

A list of Excel Financial Functions is provided below for your reference:  

 PV is the present value, the principal amount of the annuity. 

 FV is the future value, the principal plus interest on the annuity. 

 PMT is the payment made each period in the annuity. Normally, the payment is set 
 over the life of the annuity and includes principal plus interest without any other 
 fees. 

 RATE is the interest rate per period. Normally, the rate is expressed as an annual 
 percentage. 

 NPER is the total number of payment periods in the life of the annuity. You calculate 
 this number by taking the Term (the amount of time that interest is paid) and 
 multiplying it by the Period (the point in time when interest is paid or earned) so that 
 a loan with a three-year term with 12 monthly interest payments has 3 x 12, or 36 
 payment periods. 

When using financial functions, keep in mind that the fv, pv, and pmt arguments can be 
positive or negative, depending on whether you are receiving the money or paying out the 
money. Also if you want to express the rate argument in the same units as the nper 
argument you can make monthly payments on a loan and you express the nper as the total 
number of monthly payments, as in 360 (30 x 12) for a 30-year mortgage, you need to 
express the annual interest rate in monthly terms as well. 

Calculating the present value (PV) 

The PV function returns the present value of an investment, which is the total amount that a 
series of future payments is worth presently. The syntax of the PV function is as follows: 

  =PV(rate,nper,pmt,[fv],[type]) 

The fv and type arguments are optional. The fv argument is the future value or cash balance 
that you want to have after making your last payment. If you omit the fv argument, Excel 
assumes a future value of zero. The type argument indicates whether the payment is made 
at the beginning or end of the period: Enter 0 (or omit the type argument) when the 
payment is made at the end of the period and use 1 when it is made at the beginning of the 
period. 

1. Type the following data into your blank MS Excel. 

http://www.readyratios.com/reference/analysis/internal_rate_of_return_irr.html
http://www.readyratios.com/reference/analysis/internal_rate_of_return_irr.html
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2. Bold the titles, and use Wrap Text from the Alignment tab. 

 

 

The following figure contains several examples using the PV function. All three PV functions 
use the same annual percentage rate of 7.25 percent and term of 10 years. Because 
payments are made monthly, each function converts these annual figures into monthly ones.  

For example, in the PV function in cell E3, the annual interest rate in cell A3 is converted into 
a monthly rate by dividing by 12 (A3/12) and the annual term in cell B3 is converted into 
equivalent monthly periods by multiplying by 12 (B3*12). 

3. Compute for the Present Value (PV) using the formula in cells F3, F5 and F7. 

4. Compute for the Future Value (FV) by typing,  =FV(A7,10,C5*2.61934). 

 

 

The given data 

The Alignment Tab 

Using the PV function to calculate the present value of various investments. 
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Determining the future value (FV) 
The FV function calculates the future value of an investment. The syntax of this function is: 

=FV(rate,nper,pmt,[pv],[type]) 

The rate, nper, pmt, and type arguments are the same as those used by the PV function. The 
pv argument is the present value or lump-sum amount for which you want to calculate the 
future value. As with the fv and type arguments in the PV function, both the pv and type 
arguments are optional in the FV function. If you omit these arguments, Excel assumes their 
values to be zero. 

You can use the FV function to calculate the future value of an investment, such as an IRA 
(Individual Retirement Account). For example, suppose that you establish an IRA at age 43 
and will retire 22 years hence at age 65 and that you plan to make annual payments into the 
IRA at the beginning of each year. If you assume a rate of return of 8.5 percent a year, you 
would enter the following FV function in your worksheet: 

=FV(8.5%,22,-1000,1) 

Excel then indicates that you can expect a future value of $64,053.66 for your IRA when you 
retire at age 65. If you had established the IRA a year prior and the account already has a 
present value of $1,085, you would amend the FV function as follows: 

=FV(8.5%,22,-1000,-1085,1) 

In this case, Excel indicates that you can expect a future value of $70,583.22 for your IRA at 
retirement. 

StudentActivity 11.4.4.1 

 

Execute the following steps and use the Financial Functions. 

Let us consider a loan with monthly payments,  

a. an annual interest rate of 6%, 

b. a 20-year duration,  

c. a present value of $150,000 (amount borrowed) and 

d. a future value of 0 (that's what you hope to achieve when you pay off a loan). 

We make monthly payments, so we will use 6%/12 = 0.5% for RATE and 20*12 = 240 for 
NPER (total number of periods). If we make annual payments on the same loan, we use 6% 
for RATE and 20 for NPER. 

1.   Type PMT in cell A1, RATE in cell B1, NPER in cell C1, PV in Cell D1 and FV in cell E1. 
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2.   Select cell A2 and insert the PMT function. 

3.  Type the formula for PMT which is =PMT(B2,C2,D2,E2). Check your answer for PMT at 
the   end of this lesson. 

4.   Select cell B2 to calculate the interest rate.  

5.  Type the formula for RATE =RATE(C2,A2,D2,E2). Check your answers at the end of this 
lesson. 

6.   Select cell C2 to calculate for the NPER.  

7.   Type the formula for NPER, =NPER(B2,A2,D2,E2) 

8.  But, let us try to change the PMT to ($2,074.65) and see what happen to NPER. Check 
your answers at the end of this lesson. 

9.  PV (Present Value) function. If we make monthly payments of $1,074.65 on a 20-year 
loan, with an annual interest rate of 6%, type, =PV(B2,C2,A2,E2). 

10.  If you make monthly payments of only $1,000.00 for your PMT. Then type for your FV, 
=FV(B2,C2,A2,D2). Check your answers at the end of these lessons. 
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11.4.4.2 Using Logical Functions  

Using logical functions provided by Excel 2010 could apply and evaluate the specific rationale 
on the data. The most commonly used logical functions are AND, OR, and NOT. They take 
values as arguments to apply a simple logic over them and yield TRUE and FALSE result. The 
logical function helps users in situations where they want to categorise the value into 
groups, so that further complex functions can be easily performed. For example, if you want 
to check two different values that belong to different fields against a condition, you can use 
the logical function to check where the required condition is met. This may assist you in 
filtering out unwanted values and in focusing on only those values that you require. 
Additionally, Excel 2010 lets you use the multiple logical functions to check required 
conditions for the data set in one go. In what follows, we will demonstrate the usage of AND 
and OR logical functions. 

Here are the names of the logical functions along with their argument syntax: 

 AND (logical1,logical2,...)  

Tests whether the logical arguments are TRUE or FALSE. If they are all TRUE, the AND 
function returns TRUE to the cell. If any are FALSE, the AND function returns FALSE. 

 NOT (logical)  

Tests whether the logical argument is TRUE or FALSE. If TRUE, the NOT function returns 
FALSE. IF FALSE, the NOT function returns TRUE. 

 OR (logical1,logical2,...)  

Test whether the logical arguments are TRUE or FALSE. If any are TRUE, the OR function 
returns TRUE. If all are FALSE, the OR function returns FALSE. 

IF function examples for numbers: greater than, less than, equal to 

The use of the IF function with numeric values is based on using different comparison 
operators to express your conditions. You will find the full list of logical operators illustrated 
with formula examples on the next page. 

Condition Operator Formula Example Description 

Greater than > =IF(A2>5, "OK",) If the number in cell A2 is greater than 
5, the formula returns "OK"; otherwise 
0 is returned. 

Less than < =IF(A2<5, "OK", "") If the number in cell A2 is less than 5, 
the formula returns "OK"; an empty 
string otherwise. 

Equal to = =IF(A2=5, "OK", 
"Wrong number") 

If the number in cell A2 is equal to 5, 
the formula returns "OK"; otherwise the 



                   GR 11 ICT M4                                                                                                                                SPREADSHEET 2 

 

 107 

 

function displays "Wrong number". 

Not equal to <> =IF(A2<>5, "Wrong 
number", "OK") 

If the number in cell A2 is not equal to 
5, the formula returns "Wrong number 
"; otherwise - "OK". 

Greater than 
or equal to 

>= =IF(A2>=5, "OK", 
"Poor") 

If the number in cell A2 is greater than 
or equal to 5, the formula returns "OK"; 
otherwise - "Poor". 

Less than or 
equal to 

<= =IF(A2<=5, "OK", "") If the number in cell A2 is less than or 
equal to 5, the formula returns "OK"; an 
empty string otherwise. 

IF Function 
The IF function checks whether a condition is met, and returns one value if TRUE and 
another value if FALSE. 

1. Type the given data into your blank worksheet. 

 In Cell A1, type 12  In Cell B1, type 3 

2. Select C1 and type on the Formula Bar the given logical function 

 =IF(A1>10,”Correct”,”Incorrect”) 

 

 

3. Try to change the value of A1 from 0 to 9 and observe cell C1 how it will change. 

 

 

AND Function 
The AND Function returns TRUE if all conditions are true and returns FALSE if any of the 
conditions are false. 

1.  Select cell D1 and enter the following formula. 

 =IF(AND(A1>10,B1>5),”Correct”,”Incorrect”) 

The IF function returns Correct because the value in cell A1 is higher 
than 10. 

 

 

The IF function printed Incorrect because the value in cell A1 is lower than 10. 
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The AND function returns FALSE because the value in cell B2 is not higher than 5. As a result the IF function 
returns Incorrect. 

2. Try to change the value of A1 to 15 and B1 to 6 and observe cell D1 on how it will 
change. 

 

OR Function 
The OR function returns TRUE if any of the conditions are TRUE and returns FALSE if all 
conditions are false. 

1.  Select cell E1 and enter the following formula. 

 =IF(OR(A1>10,B1>5),”Correct”,”Incorrect”) 

 

The OR function returns TRUE because the value in cell A1 is higher than 10. As a result the IF function returns 
Correct. 

2. Try to change cell A1 to 8 and observe the result in cell C1 and D1. 

 

 

              Student Activity 11.4.4.2 

 

Type and execute the following steps using logical functions. 

1. Type the given data into your blank worksheet. 

In cell A1, type 20  in Cell B1, type15  in cell C1, type 10 

2. Use the IF function to compare cell A1 to a number. Select cell A3 for your answer.  

 =IF(A1<>6,”YES”,”NO”) . Check your answers at the end of the lessons.  
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3. Use the IF function to compare cells B1 and C1. Write your answer to cell C3. 

 =IF(B1<=C1,”OK”,”NOT OK”). Check your answers at the end of the lessons. 

4. Use the AND function and type this equation, select cell E1 for your answer. 

=IF(AND(B1>2,C1>8),”Less than A1”,”Greater than A1”). Check your answers at the end 
of the lessons. 

5. Use the OR function and type this equation, select cell G1 for your answer. 

=IF(OR(B1>2,C1>8),”Less than A1”,”Greater than A1”). Check your answers at the end 
of the lessons. 
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11.4.4.3 Using VLOOKUP Function 

VLOOKUP searches for the value you specify and returns a matching value from another 
column. More technically, the VLOOKUP function looks up a value in the first column of the 
specified range of cells, and returns a value in the same row from another column. 

In its common usage, Excel VLOOKUP searches through your lists of data based on the 
unique identifier and brings you a piece of information associated with that unique 
identifier. 

The letter "V" in VLOOKUP stands for "vertical". It is used to differentiate VLOOKUP from the 
HLOOKUP function that looks up a value in the top row of an array (H stands for 
"horizontal"). 

Excel VLOOKUP syntax 
The syntax for the VLOOKUP function is as follows: 

VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup]) 

The Microsoft Excel VLOOKUP function has 4 parameters, or arguments. The first three 
parameters are requited, the last one is optional. 

a.  lookup_value is the value to search for. 

This can be either a value (number, date or text) or a cell reference (reference to a cell 
containing a lookup value), or the value returned by some other Excel function.  

For example, the formula =VLOOKUP(40, A2:B15,2) will search for value 40. 

 

 

b.  table_array consists of two or more columns of data. 

 VLOOKUP function always searches for the lookup value in the first column of 
 table_array. Your table_array may contain various values such as text, dates, numbers, 
 or logical values. Values are case-insensitive, meaning that uppercase and lowercase 
 text are treated as identical. 

c.   col_index_num is the column number in table_array from which the value in the 
 corresponding row should be returned. 

 The left-most column in the specified table_array is 1, the second column is 2, the third 
 column is 3, and so on. 

d.   range_lookup determines whether you are looking for an exact match (FALSE) or 
 approximate match (TRUE or omitted). This final parameter is optional but very 
 important.  

Note: If the lookup value is smaller than the smallest value in the first column 
of your lookup array, the VLOOKUP function returns the #N/A error. 
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A. To do VLOOKUP in Excel in a worksheet 
 Type and follow the instructions using VLOOKUP Functions 

1. Type the given data into your blank worksheet. 

 In cell, A1 Speed (mph)  B1 Animal 

    A2 30    B2 Cat 

    A3 32    B3 Reindeer 

    A4 35    B4 Rabbit 

    A5 70    B5 Cheetah 

    A6 61    B6 Antelope 

    A7 40    B7 Ostrich 

    A8 42    B8 Gray fox 

    A9 43    B9 Coyote 

    A10 50    B10 Lion 

2. Type the formula =VLOOKUP(40, A2:B15,2)  

You can read the entire formula =VLOOKUP(40, A2:B10,2). The formula searches for 
"40" in cells A2 through A10 and returns a matching value from column B (because B is 
the 2nd column in the specified table_array A2:B10). Specified table_array A2:B10. 

3. Select D2 to show your answer and to type your VLOOKUP formula. 

 

4. Save this work with a filename My_Activity8. 

 

 

Find value 40 

Search A1 to A10, 1
st

 

column of table_array 

Return a matching 

value from column B 

Note. If your col_index_num argument is less than 1, the VLOOKUP formula 
will return the #VALUE! error. In case it is greater than the number of 
columns in table_array, your function will return the #REF! error. 
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B. To do VLOOKUP in Excel from another worksheet 
In practice, VLOOKUP formulas are rarely used to find data in the same worksheet. 
Most often you will have to look up and pull the matching data from a different sheet. 

To do a vlookup from a different Excel sheet, you should enter the worksheet's name 
and an exclamation mark in the table_array argument before the range of cells, e.g. 
=VLOOKUP(40, Sheet2!A2:B15,2). The formula indicates that the lookup range A2:B15 
is located in Sheet2. 

Of course, you do not have to type the sheet's name manually. Simply start typing the 
formula and when it comes to the table_array argument, switch to the lookup 
worksheet and select the range using a mouse. 

 

 

 

C. To do a VLOOKUP in Excel with exact match 
As you remember, to search for exact match, you have to put FALSE as the final 
argument in a VLOOKUP formula in Excel. 

Let us take the 'Animal speed' table from the very first example again and find out 
which animal can run 50 miles per hour. I believe you will not have any difficulties with 
the formula: =VLOOKUP(50,$A$2:$B$15,2,FALSE). 

D. Using VLOOKUP in Excel with approximate match 
When using VLOOKUP formulas with approximate match, for example with 
range_lookup set to TRUE or omitted, the first thing you need to do is sort the first 
column in your lookup range in ascending order. 

                                                                 

 This is very important because your VLOOKUP formula is going to return the next 
 largest value for the lookup value you specify and then stop searching. If you neglect to 
 sort your data properly, you will end up having really strange results or the #N/A error. 
 And now you can utilise either of the following formulas: 

=VLOOKUP(69,$A$2:$B$15,2,TRUE) 

=VLOOKUP(69,$A$2:$B$15,2) 

Arranged in ascending 

order. 

Note: It is a good idea to always use absolute cell references (with $) in the 
table_array parameter of VLOOKUP formulas. In this case, the lookup range 
will remain constant when you copy the formula to other cells. 
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Student Activity 11.4.4.3 

Follow the steps below. 

1. Using our file My_Activity8, to look for the value of 70 in column A and write your 
answer in cell E3. 

 =VLOOKUP(70,A2:B5,2).  

Check your answers at the end of the lessons. 

2. Look for the value of 35 in column A and write your answer in cell F5. 

 =VLOOKUP(35,A5:B10,2).  

Check your answers at the end of the lessons. 
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11.4.4.4 Creating a New Workbook Using a Template 

In Excel 2010, you have many templates that can save you a lot of time. A template is a pre-
designed Spreadsheet you can use to create new Spreadsheet with the same formatting and 
pre-defined formulas. With templates, you do not need to know how to do the math, or 
even how to write formulas—these are already integrated into the Spreadsheet. 

In this lesson, you will learn how to create a new workbook with a template, as well as basic 
information about how templates work in Excel 2010. 

Creating a new workbook using a template 

You can create a workbook based on a template Iinstead of creating an Excel workbook from 
scratch. There are many free templates available, waiting to be used. 

A. Existing Templates 
 To create a workbook based on an existing template, execute the following steps. 

1.  On the green File tab, click New. 

2.  To choose a template from one of the sample templates (these are already  installed on 
your computer), click on Sample templates. 

 

 

3.   To choose a template from the Office.com Templates, click a category, for example, 
click Calendars. 

 

The Sample Templates 

The Calendar Template 
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4.  To download a template, select a template and then click Download.  

 

 

 

 

 

 

 

 

 

Excel creates a workbook (UniversalCalendar1.xlsx) based on this template. Excel also stores 
the template (UniversalCalendar.xltx) in the Templates folder.  

B. Create a Template 
 If you create your own template, you can safely store 
 it in the Templates folder. As a result, you can create 
 new workbooks based on this template without 
 worrying that you overwrite the original file. 

1.  Create a workbook.  

2.  On the green File tab, click Save As. 

3.  Enter a file name. 

4.  Select Excel Template (*.xltx) from the drop-   
 down list. 

Excel automatically activates the Templates folder. Notice the location of the Templates 
folder on your computer. It is usually located here:  
C:\Users\<username>\AppData\Roaming\Microsoft\Templates 

5.  Click Save. 

Using templates can save you a lot of time. A template is a pre-designed Spreadsheet you 
can use to create new Spreadsheet with the same formatting and pre-defined formulas. 
With templates, you do not need to know how to do the math, or even how to write 
formulas—these are already integrated into the Spreadsheet. 

 

Downloaded templates in MS Excel 

To download in 

Office.com 
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      Student Activity 11.4.4.4 

 
Write the steps on how to open a certain sample templates which are already installed on 
your computer. Try to open Family Calendar, in ANY YEAR folder. 

1. _____________________________________________________________________ 

2. _____________________________________________________________________ 

3. _____________________________________________________________________ 

4. _____________________________________________________________________ 

5. _____________________________________________________________________ 

6. _____________________________________________________________________ 
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11.4.4.5 Protecting a Worksheet Style, Contents and Elements 

A. Protect Worksheet 
You may want to protect a worksheet for a variety of reasons.  One reason is to 
prevent yourself or others from accidentally deleting formulas or other critical data. A 
common scenario is  to protect a worksheet so that the data can be changed, but 
the formulas cannot be changed. 

To protect a worksheet follow the steps below. 

1. Choose Review         Changes group       Protect Sheet.  

2. Excel displays the Protect Sheet dialogue box.  

Providing a password is optional. If you enter a password, 
that password will be required to unprotect the 
worksheet. You can select various options in which the 
sheet should be protected. Suppose we check Format Cells 
option then Excel will not allow to format cells. 

3. Enter your password 123. Click OK. 

4. Another message will appear on your screen. Reenter your 
password 123. 

5. Click OK. 

 

 

 

When somebody tries to format the cells he or she will come across the error as displayed 
on the next page. 

 

 

B. Unprotect a protected sheet 
 To unprotect a protected sheet, follow the steps below. 

1. Choose Review         Changes group         Unprotect Sheet.  

Protect Sheet Tab 

To confirm your password 

The error message 

 
To unprotect the sheet 
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2. If the sheet was protected with a password, you are prompted to enter that password. 

3. Type the password 123.  

4. Click OK. 

Protecting a worksheet is to prevent yourself or others from accidentally deleting formulas 
or other critical data. A common scenario is to protect a worksheet so that the data can be 
changed, but the formulas cannot be changed. 

Let us try to type this sample worksheet into our blank worksheet. 

 

 

1.  Compute for the TOTAL. 

2.  Protect column B. 

 

 

 

 

 

 

3. Let us try to a password by typing “Sample123”. 

 

 

 

 

 

 

Sample Worksheet 

 

To protect column B. 

 

Typing the password 
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4.  Click OK. 

5.  You are about to re-enter the password that you 
typed, which is Sample123 to confirm. 

6.  Click OK. 

7.  Save your data My_Activity10. 

 

         Student Activity 11.4.4.5 

 

Use the data of the file My_Activity10, create and write the steps on Protecting a worksheet 
style, content and elements. Create a password Sample457. 

1. ______________________________________________________________________ 

2. ______________________________________________________________________ 

3. ______________________________________________________________________ 

4. ______________________________________________________________________ 

5. ______________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 

 
Re-entering the password 
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11.4.4.6 Protecting the Worksheet from Unauthorised User Access 

We can apply security to the workbook by the concept of protection available in the Review 
Tab of ribbon. MS Excel's protection-related features fall into three categories. 

 Worksheet protection: Protecting a worksheet from being 
modified, or restricting the modifications to certain users  

 Workbook protection: Protecting a workbook from having 
sheets inserted or deleted, and also requiring the use of 
password to open the workbook 

A. Protecting a Workbook 
 Excel provides three ways to protect a workbook. 

1. Require a password to open the workbook. 

2. Prevent users from adding sheets, deleting sheets, hiding 
sheets, and unhiding sheets. 

3. Prevent users from changing the size or position of windows. 

Requiring a password to open a workbook 

Excel allows you save a workbook with a password. After doing so, whoever tries to 
open the workbook must enter the password. To add a password to a workbook, 
follow these steps. Use your sample data from your Activity 11.4.4.5. 

1. Choose File  Info  Protect Workbook  Encrypt With Password. 

2. Excel displays the Encrypt Document dialogue box. Type a password. 

 

 

 

3. Click OK. 

4. Confirm the password by typing the password again. 

 

 

 

 

5. Click OK. 

To encrypt with password 

Encrypt Document 

 
Enter Password 

Confirm the password 
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After clicking OK the Protect Workbook box will change its colour to dark orange, and a 
message will come out. 

 

 

 

6. Save the workbook, My_Activity11. 

7. Go out from your activity by clicking the Close Button. 

8. Try to open your My_Activity11 and a message will come out before you can see your 
worksheet.  

To remove a password from a workbook, repeat the same procedure. In Step 2, 
however, delete the existing password symbols. 

B. Protecting workbook’s structure and Windows 
To prevent others (or yourself) from performing certain 
actions in a workbook, you can protect the workbook’s 
structure and windows. When a workbook’s structure 
and windows is protected, the user may not Add a 
sheet, Delete a sheet, Hide a sheet, unhide a sheet, etc. 
and may not allowed to change size or position of a 
workbook’s windows respectively. 

 

To protect a worksheet’s structure and windows, follow  the steps below. 

1. To display the Protect Workbook dialogue box. 

  Choose Review Changes group  Protect Workbook.  

 In the Protect Workbook dialogue box, select the Structure check box and Windows 
check box. 

 (Optional) Enter a password.  

 Click OK. 

Protecting a worksheet from unauthorised user requires a password to open the workbook it 
also prevent users from adding sheets, deleting sheets, hiding sheets, and unhiding sheets 
and prevent users from changing the size or position of windows. Let us try to protect the 
worksheet with filename My_Activity11 by creating a password “123”.  

 

 

 
Protect workbook tab 

Permission, Protect workbook 
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                 Student Activity 11.4.4.6 

List the steps on how to protect the worksheet from unauthorised user access. 

1. ______________________________________________________________________ 

 ______________________________________________________________________ 

2. _______________________________________________________________________ 

 _______________________________________________________________________ 

3. _______________________________________________________________________ 

 _______________________________________________________________________ 

4. _______________________________________________________________________ 

 _______________________________________________________________________ 

5. _______________________________________________________________________ 

 _______________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                   GR 11 ICT M4                                                                                                                                SPREADSHEET 2 

 

 123 

 

Summative Activities 11.4 

A. Follow the steps using Financial Functions 

 Let us change a loan with monthly payments,  

a. an annual interest rate of 5%, 

b.  a 10-year duration,  

c. a present value of $100,000 (amount borrowed) and 

d.  a future value of 0 (that is what you hope to achieve when you pay off a loan). 

Use 5%/12 = 0.42% for RATE and 10*12 = 120 for NPER (total number of periods). If we 
make annual payments on the same loan, we use 4.2% for RATE and 10 for NPER. 

Solve for PMT 

 

B.  Type the given data into your blank worksheet. 

 Given: 

 

1.   Type the given data above into your blank worksheet. 

2.   Use row 5 to write your answers. 

3.   For column A5, compare A3 with B3 and print YES if A3 is greater than B3 or else NO. 

4.   For column B5, compare B3 with C3 and print YES if B3 is less than C3 or else NO. 

C.   Follow and execute the given steps using the VLOOKUP functions. 

 Using our data files in filename My_Activity8. 

1.   Look for the value of 43 in column A and write your answer in cell G1 using VLOOKUP 
with exact match. 
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2.   Look for the value of 69 in column A and write your answer in cell G4 using VLOOKUP 
with approximate match. 

 

 

  Answers to Student Activities 11.4.4 

Student Activity 11.4.4.1 

PMT 

 

 

 

 

 

 

 

 

Result. The monthly payment equals $1,074.65. 
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RATE 

 

NPER 

 

 

PV 

 

 

To calculate for the Rate. 
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Student Activity 11.4.4.2  

1. =IF(A1<>6,”YES”,”NO”)   

 

2. =IF(B1<=C1,”OK”,”NOT OK”) 

 

3. =IF(AND(B1>2,C1>8),”Less than A1”,”Greater than A1”) 

 

4.  =IF(OR(B1>2,C1>8),”Less than A1”,”Greater than A1”) 

 

Student Activity 11.4.4.3 

VLOOK UP 

1.  
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2.  

 

 

Student Activity 11.4.4.4 

1. Click File Tab of MS Excel. 

2. Select New tab to open available templates in MS Excel. 

3. Choose Any Year folder from the templates available in MS Excel. 

4. Click OK. 

5. Choose Family Calendar. 

6. Click OK. 

Student Activity 11.4.4.5 

1. Protect the data by entering your password Sample457. 

2. Tick Edit Objects from the Protect Sheet menu. 

3. Try to type or edit any of the cells and see what will happen. 

4. Unprotect your Sheet by entering the password Sample457. 

5. Click OK. 

Student Activity 11.4.4.6 

1. Choose File  Info  Protect Workbook  Encrypt With Password. 

2. Excel displays the Encrypt Document dialogue box. Type a password. 

3. Click OK. 

4. Confirm the password by typing the password again.  

5. Click OK. 
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Answers to Summative Activities 11.4.4 

 

A. Financial Functions 

 PMT, =PMT(B2,C2,D2,E2) 

 

B. 

 Logical Functions 

 

C. 

 VLOOK UP 

1. 

 

 

 

2.   
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Summary 

Excel is a spreadsheet program in the Microsoft Office system. You can use Excel to create 
and format workbooks (a collection of spreadsheets) in order to analyse data and make 
more informed business decisions. Specifically, you can use Excel to track data, build models 
for analysing data, write formulas to perform calculations on that data, pivot the data in 
numerous ways, and present data in a variety of professional looking charts. 

With Excel you can analyse, manage and share information quickly and easily to make more 
informed decisions. With the new user interface, rich data visualization, and PivotTable 
views, professional-looking charts are easier to create and use than ever before.  

The best part about a spreadsheet is - you do not have to do any adding up yourself. The 
program will add the numbers up for you.  Spreadsheets are software programs consisting of 
a grid of data cells that can be used to organise, analyse and graphically represent data.  

A spreadsheet does not only add up, of course. It can do a whole lot more besides simple 
arithmetic. It can handle financial calculations, statistical information, and do complex 
trigonometry. And it can make a pretty graph for you. Though, a Spreadsheet is just a 
glorified calculator. Using a spreadsheet is to do some number crunching. The software will 
puzzle out the answers to sums for you, and save you a lot of time and effort carrying 
numbers.  

Spreadsheet also let you to protect a worksheet for a variety of reasons. One reason is to 
prevent yourself or others from accidentally deleting formulas or other critical data. A 
common scenario is  to protect a worksheet so that the data can be changed, but the 
formulas cannot be changed. 
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Glossary 

3-D reference 
A reference to a range that spans two or more worksheets in a workbook. 

3-D walls and floor 
The areas surrounding many 3-D chart types that give dimension and boundaries to the 
chart. Two walls and one floor are displayed within the plot area. 

Activate 
To make a chart sheet or worksheet the active, or selected, sheet. The sheet that you 
activate determines which tabs are displayed. To activate a sheet, click the tab for the sheet 
in the workbook. 

Active cell 
The selected cell in which data is entered when you begin typing. Only one cell is active at a 
time. The active cell is bounded by a heavy border. 

Active sheet 
The sheet that you are working on in a workbook. The name on the tab of the active sheet is 
bold. 

Address 
The path to an object, document, file, page, or other destination. An address can be a URL 
(Web address) or a UNC path (network address), and can include a specific location within a 
file, such as a Word bookmark or an Excel cell range. 

Alternate start up folder 
A folder in addition to the XLStart folder that contains workbooks or other files that you 
want to be opened automatically when you start Excel and templates that you want to be 
available when you create new workbooks. 

Annuity 
A specified income payable at stated intervals for a fixed or a contingent period, often for 
the recipient’s life, in consideration of a stipulated premium paid either in prior instalment 
payments or in a single payment. 
The right to receive such as income. 

Argument 
The values that a function uses to perform operations or calculations. The type of argument 
a function uses is specific to the function. Common arguments that are used within functions 
include numbers, text, cell references, and names. 

Array 
Used to build single formulas that produce multiple results or that operate on a group of 
arguments that are arranged in rows and columns. An array range shares a common 
formula; an array constant is a group of constants used as an argument. 

Array formula 
A formula that performs multiple calculations on one or more sets of values, and then 
returns either a single result or multiple results. Array formulas are enclosed between braces 
{ } and are entered by pressing CTRL+SHIFT+ENTER. 
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Associated PivotTable report 
The PivotTable report that supplies the source data to the PivotChart report. It is created 
automatically when you create a new PivotChart report. When you change the layout of 
either report, the other also changes. 

Auto format 
A built-in collection of cell formats (such as font size, patterns, and alignment) that you can 
apply to a range of data. Excel determines the levels of summary and detail in the selected 
range and applies the formats accordingly. 

Average Function 
It returns the average (arithmetic mean) of the arguments. For example, if the range A1:A20 
contains numbers, the formula,  =AVERAGE(A1:A20) returns the average of those numbers.  
AVERAGE(NUMBER1*NUMBER2+,….) 

Axis 
A line bordering the chart plot area used as a frame of reference for measurement. The y 
axis is usually the vertical axis and contains data. The x-axis is usually the horizontal axis and 
contains categories. 

Base address 
The relative path that Excel uses for the destination address when you insert a hyperlink. 
This can be an Internet address (URL), a path to a folder on your hard drive, or a path to a 
folder on a network. 

Bevel 
An edge that is canted, one that is not a 90 degree angle. 

Border 
A decorative line that can be applied to worksheet cells or objects, such as charts, pictures, 
or text boxes. Borders distinguish, emphasise, or group items. 

Calculated column 
In an Excel table, a calculated column uses a single formula that adjusts for each row. It 
automatically expands to include additional rows so that the formula is immediately 
extended to those rows. 

Calculated field (database) 
A field in the result set of a query that displays the result of an expression rather than data 
from a database. 

Calculated field (PivotTable report) 
A field in a PivotTable report or PivotChart report that uses a formula you create. Calculated 
fields can perform calculations by using the contents of other fields in the PivotTable report 
or PivotChart report. 

Calculated item 
An item within a PivotTable field or PivotChart field that uses a formula you create. 
Calculated items can perform calculations by using the contents of other items within the 
same field of the PivotTable report or PivotChart report. 

Category axis 
A chart axis that represents the category for each data point. It displays arbitrary text values 
like Qtr1, Qtr2, and Qtr3; it cannot display scaled numerical values. 
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Category field 
A field that is displayed in the category area of the PivotChart report. Items in a category 
field appear as the labels on the category axis. 

Cell 
A box formed by the intersection of a row and column in a worksheet or a table, in which 
you enter information. 

Cell reference 
The set of coordinates that a cell occupies on a worksheet. For example, the reference of the 
cell that appears at the intersection of column B and row 3 is B3. 

Change history 
In a shared workbook, information that is maintained about changes made in past editing 
sessions. The information includes the name of the person who made each change, when 
the change was made, and what data was changed. 

Chart area 
The entire chart and all its elements. 

Chart sheet 
A sheet in a workbook that contains only a chart. A chart sheet is beneficial when you want 
to view a chart or a PivotChart report separately from worksheet data or a PivotTable report. 

Column field 
A field that is assigned a column orientation in a PivotTable report. Items associated with a 
column field are displayed as column labels. 

Column heading 
The shaded area at the top of each Data pane column that contains the field name. 

Column heading 
The lettered or numbered gray area at the top of each column. Click the column heading to 
select an entire column. To increase or decrease the width of a column, drag the line to the 
right of the column heading. 

Comparison criteria 
A set of search conditions that is used to find data. Comparison criteria can be a series of 
characters that you want to match, such as "Northwind Traders," or an expression, such as 
">300." 

Comparison operator 
A sign that is used in comparison criteria to compare two values. The six standards are = 
Equal to, > Greater than, < Less than, >= Greater than or equal to, <= Less than or equal to, 
and <> Not equal to. 

Conditional format 
A format, such as cell shading or font colour, that Excel automatically applies to cells if a 
specified condition is true. 

Consolidation table 
The table of combined results that appears in the destination area. Excel creates the 
consolidation table by applying the summary function that you select to the source area 
values that you specify. 
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Constant 
A value that is not calculated. For example, the number 210 and the text "Quarterly 
Earnings" are constants. An expression, or a value resulting from an expression, is not a 
constant. 

Constraints 
The limitations placed on a Solver problem. You can apply constraints to adjustable cells, the 
target cell, or other cells that are directly or indirectly related to the target cell. 

Copy area 
The cells that you copy when you want to paste data into another location. After you copy 
cells, a moving border appears around them to indicate that they have been copied. 

Criteria 
Conditions you specify to limit which records are included in the result set of a query. For 
example, the following criterion selects records for which the value for the Order Amount 
field is greater than 30,000: Order Amount > 30000. 

Criteria pane 
The area of the window that displays the criteria used to limit the records included in the 
result set of your query. 

Data form 
A dialogue box that displays one complete record at a time. You can use data forms to add, 
change, locate, and delete records. 

Data label 
A label that provides additional information about a data marker, which represents a single 
data point or value that originates from a datasheet cell. 

Data marker 
A bar, area, dot, slice, or other symbol in a chart that represents a single data point or value 
that originates from a datasheet cell. Related data markers in a chart constitute a data 
series. 

Data pane 
The area of the window that displays the result set of your query. 

Data points 
Individual values that are plotted in a chart. Related data points make up a data series. Data 
points are represented by bars, columns, lines, slices, dots, and other shapes. These shapes 
are called data markers. 

Data region 
A range of cells that contains data and that is bounded by empty cells or datasheet borders. 

Data series 
Related data points that are plotted in a chart and originate from datasheet rows or 
columns. Each data series in a chart has a unique colour or pattern. You can plot one or 
more data series in a chart. Pie charts have only one data series. 
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Data source 
A stored set of "source" information used to connect to a database. A data source can 
include the name and location of the database server, the name of the database driver, and 
information that the database needs when you log on. 

Data source driver 
A program file used to connect to a specific database. Each database program or 
management system requires a different driver. 

Data table 
A range of cells that shows the results of substituting different values in one or more 
formulas. There are two types of data tables: one-input tables and two-input tables. 

Data table in charts 
A grid that can be added to some charts and contains the numeric data used to create the 
chart. The data table usually is attached to the horizontal axis of the chart and replaces the 
tick-mark labels on the horizontal axis. 

Data validation 
An Excel feature that you can use to define restrictions on what data can or should be 
entered in a cell, and to display messages that prompt users for correct entries and notify 
users about incorrect entries. 

Database 
A collection of data related to a particular subject or purpose. Within a database, 
information about a particular entity, such as an employee or order, is categorised into 
tables, records, and fields. 

DDE conversation 
The interaction between two applications that are communicating and exchanging data 
through special functions and code known as dynamic data exchange (DDE). 

Default start up workbook 
The new, unsaved workbook that is displayed when you start Excel. The default startup 
workbook is displayed only if you haven't included other workbooks in the XLStart folder. 

Default workbook template 
The Book.xlt template that you create to change the default format of new workbooks. Excel 
uses the template to create a blank workbook when you start Excel or create a new 
workbook without specifying a template. 

Default worksheet template 
The Sheet.xlt template that you create to change the default format of new worksheets. 
Excel uses the template to create a blank worksheet when you add a new worksheet to a 
workbook. 

Dependents 
Cells that contain formulas that refer to other cells. For example, if cell D10 contains the 
formula =B5, cell D10 is a dependent of cell B5. 

Destination area 
The range of cells that you select to hold the summarised data in a consolidation. The 
destination area can be on the same worksheet as the source data or on a different 
worksheet. A worksheet can contain only one consolidation. 
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Detail data 
For automatic subtotals and worksheet outlines, the subtotal rows or columns that are total 
by summary data. Detail data is typically adjacent to and either above or to the left of the 
summary data. 

Drop lines 
In line and area charts, lines that extend from a data point to the category (x) axis. Useful in 
area charts to clarify where one data marker ends and the next begins. 

Drop-down list box 
A control on a menu, toolbar, or dialogue box that displays a list of options when you click 
the small arrow next to the list box. 

Embedded chart 
A chart that is placed on a worksheet rather than on a separate chart sheet. Embedded 
charts are beneficial when you want to view or print a chart or a PivotChart report with its 
source data or other information in a worksheet. 

Error bars 
Usually used in statistical or scientific data, error bars show potential error or degree of 
uncertainty relative to each data marker in a series. 

Excel add-in 
Components that can be installed on your computer to add commands and functions to 
Excel. These add-in programs are specific to Excel. Other add-in programs that are available 
for Excel or Office are Component Object Model (COM) add-ins. 

Excel table 
Formerly known as an Excel list, you can create, format, and expand an Excel table to 
organise the data on your worksheet. 

Expression 
A combination of operators, field names, functions, literals, and constants that evaluates to 
a single value. Expressions can specify criteria (such as Order Amount>10000) or perform 
calculations on field values (such as Price*Quantity). 

External data 
Data that is stored in a database, such as Access, dBASE, or SQL Server, that is separate from 
Query and the program from which you started Query. 

External data 
Data that is stored outside of Excel. Examples include databases created in Access, dBASE, 
SQL Server, or on a Web server. 

External data range 
A range of data that is brought into a worksheet but that originates outside of Excel, such as 
in a database or text file. In Excel, you can format the data or use it in calculations as you 
would any other data. 

External reference 
A reference to a cell or range on a sheet in another Excel workbook, or a reference to a 
defined name in another workbook. 
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Field (database) 
A category of information, such as last name or order amount, that is stored in a table. 
When Query displays a result set in its Data pane, a field is represented as a column. 

Field (PivotTable report) 
In a PivotTable or PivotChart report, a category of data that is derived from a field in the 
source data. PivotTable reports have row, column, page, and data fields. PivotChart reports 
have series, category, page, and data fields. 

Fill handle 
The small black square in the lower-right corner of the selection. When you point to the fill 
handle, the pointer changes to a black cross. 

Filter 
To display only the rows in a list that satisfy the conditions you specify. You use the 
AutoFilter command to display rows that match one or more specific values, calculated 
values, or conditions. 

Font 
A graphic design applied to all numerals, symbols, and alphabetic characters. Also called type 
or typeface. Arial and Courier New are examples of fonts. Fonts usually come in different 
sizes, such as 10 point, and various styles, such as bold. 

Formula 
A sequence of values, cell references, names, functions, or operators in a cell that together 
produce a new value. A formula always begins with an equal sign (=). 

Formula bar 
A bar at the top of the Excel window that you use to enter or edit values or formulas in cells 
or charts. Displays the constant value or formula stored in the active cell. 

Formula Palette 
A tool that helps you create or edit a formula and also provides information about functions 
and their arguments. 

Function (Microsoft Query) 
An expression that returns a value based on the results of a calculation. Query assumes that 
data sources support the Avg, Count, Max, Min, and Sum functions. Some data sources may 
not support all of these, or may support additional functions. 

Function (Office Excel) 
A prewritten formula that takes a value or values, performs an operation, and returns a 
value or values. Use functions to simplify and shorten formulas on a worksheet, especially 
those that perform lengthy or complex calculations. 

Grid 
A set of intersecting lines used to align objects. 

Gridlines in charts 
Lines you can add to a chart that makes it easier to view and evaluate data. Gridlines extend 
from the tick marks on an axis across the plot area. 

 

 



                   GR 11 ICT U4                                                                                                                                    SPREADSHEET 2 

 

138  

 

Group 
In an outline or PivotTable report, one or more detail rows or columns that are adjacent and 
subordinate to a summary row or column. 
High-low lines 
In 2-D line charts, lines that extend from the highest to the lowest value in each category. 
High-low lines are often used in stock charts. 

History worksheet 
A separate worksheet that lists changes being tracked in a shared workbook, including the 
name of the person who made the change, when and where it was made, what data was 
deleted or replaced, and how conflicts were resolved. 

Identifier 
A field name used in an expression. For example, Order Amount is the identifier (field name) 
for a field that contains order amounts. You can use an expression (such as Price*Quantity) 
in place of an identifier. 

Implicit intersection 
A reference to a range of cells, instead of a single cell, that is calculated like a single cell. If 
cell C10 contains the formula =B5:B15*5, Excel multiplies the value in cell B10 by 5 because 
cells B10 and C10 are in the same row. 

Index 
A database component that speeds up searching for data. When a table has an index, data in 
the table can be found by looking it up in the index. 

Inner join 
In Query, default type of join between two tables where only the records that have the same 
values in the joined fields are selected. The two matching records from each table are 
combined and displayed as one record in the result set. 

Input cell 
The cell in which each input value from a data table is substituted. Any cell on a worksheet 
can be the input cell. Although the input cell does not need to be part of the data table, the 
formulas in data tables must refer to the input cell. 

Insert row 
In an Excel table, a special row that facilitates data entry. The Insert row is indicated by an 
asterisk. 

Internet Explorer 
A Web browser that interprets HTML files, formats them into Web pages, and displays them 
to the user. You can download Internet Explorer from the Microsoft Web site at 
http://www.microsoft.com. 

Item 
A subcategory of a field in PivotTable and PivotChart reports. For instance, the field "Month" 
could have items such as "January," "February," and so on. 

Iteration 
Repeated calculation of a worksheet until a specific numeric condition is met. 
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Join 
A connection between multiple tables where records from related fields that match are 
combined and shown as one record. Records that do not match may be included or 
excluded, depending on the type of join. 

Join line 
In Query, a line that connects fields between two tables and shows Query how the data is 
related. The type of join indicates which records are selected for the query's result set. 

Justify 
To adjust horizontal spacing so that text is aligned evenly along both the left and right 
margins. Justifying text creates a smooth edge on both sides. 

Legend 
A box that identifies the patterns or colours that are assigned to the data series or categories 
in a chart. 

Legend keys 
Symbols in legends that show the patterns and colours assigned to the data series (or 
categories) in a chart. Legend keys appear to the left of legend entries. Formatting a legend 
key also formats the data marker that's associated with it. 

Locked field or record 
The condition of a record, field, or other object in a database that permits it to be viewed 
but not changed (read-only) in Query. 

Marquee 
Another term in MS Excel for marching ants. 

Matrix 
A rectangular array of values or a range of cells that is combined with other arrays or ranges 
to produce multiple sums or products. Excel has predefined matrix functions that can 
produce the sums or products. 

MAX Function 
It describes the formula syntax and usage of the MAX function in Microsoft Excel. It returns 
the largest value in a set of value. MAX(number1,*number2+,…). The arguments can either 
be numbers or names, arrays, or references that contains numbers. 

Merged cell 
A single cell that is created by combining two or more selected cells. The cell reference for a 
merged cell is the upper-left cell in the original selected range. 

Microsoft Excel control 
A native Excel control other than an ActiveX control. 

Microsoft Visual Basic Help 
To get help for Visual Basic in Excel, on the Developer tab, in the Code group, click Visual 
Basic, and then under the Help menu, click Microsoft Visual Basic Help. 

MIN Function 
Microsoft Excel function returns the smallest value from the numbers provided the syntax 
for the MIN function in Microsoft Excel is MIN(number1*number2,…number_n+). 
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Moving average 
A sequence of averages computed from parts of a data series. In a chart, a moving average 
smooth the fluctuations in data, thus showing the pattern or trend more clearly. 

Moving border 
An animated border that appears around a worksheet range that has been cut or copied. To 
cancel a moving border, press ESC. 

Multiple-level category labels 
Category labels in a chart that, based on worksheet data, are automatically displayed on 
more than one line in a hierarchy. For example, the heading Produce might appear above a 
row with headings Tofu, Apples, and Pears. 

Name 
A word or string of characters that represents a cell, range of cells, formula, or constant 
value. Use easy-to-understand names, such as Products, to refer to hard to understand 
ranges, such as Sales!C20:C30. 

Name box 
Box at left end of the formula bar that identifies the selected cell, chart item, or drawing 
object. To name a cell or range, type the name in the Name box and press ENTER. To move 
to and select a named cell, click its name in the Name box. 

Nonadjacent selection 
A selection of two or more cells or ranges that do not touch each other. When plotting 
nonadjacent selections in a chart, make sure that the combined selections form a 
rectangular shape. 

ObjectLink 
An OLE data format that describes a linked object, identifying the class, document name, and 
name of an object. Each of these data items is a null-terminated string. 

OLAP 
A database technology that has been optimised for querying and reporting, instead of 
processing transactions. OLAP data is organised hierarchically and stored in cubes instead of 
tables. 

OLAP provider 
A set of software that provides access to a particular type of OLAP database. This software 
can include a data source driver and other client software that is necessary to connect to a 
database. 

Operand 
Items on either side of an operator in a formula. In Excel, operands can be values, cell 
references, names, labels, and functions. 

Operator 
A sign or symbol that specifies the type of calculation to perform within an expression. There 
are mathematical, comparison, logical, and reference operators. 

Outer join 
In Query, a join where all records from one table are selected, even if there are no matching 
records in another table. Records that match are combined and shown as one. Records that 
do not have matches in the other table are shown empty. 
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Outer join 
Join in which all records from one table are selected, even if there are no matching records 
in another table. Records that matches are combined and shown as one. Records that do not 
have matches in the other table are shown as empty. 

Outline 
Worksheet data in which rows or columns of detail data are grouped so that you can create 
summary reports. The outline can summarise either an entire worksheet or a selected 
portion of it. 

Outline data 
The data that is contained within a worksheet outline. Outline data includes both the 
summary and detail rows or columns of an outline. 

Outline symbols 
Symbols that you use to change the view of an outlined worksheet. You can show or hide 
detailed data by pressing the plus sign, minus sign, and the numbers 1, 2, 3, or 4, indicating 
the outline level. 

Page break 
Divider that breaks a worksheet into separate pages for printing. Excel inserts automatic 
page breaks based on the paper size, margin settings, scaling options, and the positions of 
any manual page breaks that you insert. 

Page break preview 
Worksheet view that displays the areas to be printed and the locations of page breaks. The 
area to be printed is displayed in white, automatic page breaks appear as dashed lines, and 
manual page breaks appear as solid lines. 

Parameter 
In Excel, you can add, change, or remove parameters to specify cells that are editable in the 
viewable worksheet data of Excel Services. When you save the workbook, the changes are 
automatically reflected on the server. 

Parameter query 
A type of query that, when you run it, prompts for values (criteria) to use to select the 
records for the result set so that the same query can be used to retrieve different result sets. 

Password 
A way to protect your worksheet or workbook. When you protect worksheet or workbook 
elements with a password, it is very important that you remember that password. Without 
it, there is no way to unprotect the workbook or worksheet. You should always use strong 
passwords that combine uppercase and lowercase letters, numbers, and symbols. Weak 
passwords don't mix these elements. Strong password: Y6dh!et5. Weak password: House27. 
Use a strong password that you can remember so that you don't have to write it down. 

Paste area 
The target destination for data that is been cut or copied by using the Office Clipboard. 

Pivot area 
The worksheet area into which you drag PivotTable or PivotChart fields to change the layout 
of the report. On a new report, dashed blue outlines indicate the pivot area on the 
worksheet. 
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PivotChart category field 
A field that is assigned a category orientation in a PivotChart report. In a chart, categories 
usually appear on the x-axis, or horizontal axis, of the chart. 

PivotChart report 
A chart that provides interactive analysis of data, like a PivotTable report. You can change 
views of data, see different levels of detail, or reorganise the chart layout by dragging fields 
and by showing or hiding items in fields. 

PivotChart series field 
A field that is assigned a series orientation in a PivotChart report. In a chart, series are 
represented in the legend. 

PivotTable data 
In a PivotTable report, the summarised data that is calculated from the data fields of a 
source list or table. 

PivotTable grand totals 
Total values for all cells in a row or all cells in a column of a PivotTable report. Values in a 
grand total row or column are calculated by using the same summary function used in the 
data area of the PivotTable report. 

PivotTable list 
A Microsoft Office Web Component that allows you to create a structure similar to an Excel 
PivotTable report. Users can view the PivotTable list in a Web browser and change its layout 
in a manner similar to an Excel PivotTable report. 

PivotTable report 
An interactive, cross-tabulated Excel report that summarises and analyses data, such as 
database records, from various sources including ones external to Excel. 

PivotTable subtotal 
A row or column that uses a summary function to display the total of detail items in a 
PivotTable field. 

Plot area 
In a 2-D chart, the area bounded by the axes, including all data series. In a 3-D chart, the 
area bounded by the axes, including the data series, category names, tick-mark labels, and 
axis titles. 

Point 
A unit of measurement equal to 1/72 of an inch. 

Precedents 
Cells that are referred to by a formula in another cell. For example, if cell D10 contains the 
formula =B5, cell B5 is a precedent to cell D10. 

Primary key 
One or more fields that uniquely identify each record in a table. In the same way that a 
license plate number identifies a car, the primary key uniquely identifies a record. 

Print area 
One or more ranges of cells that you designate to print when you do not want to print the 
entire worksheet. If a worksheet includes a print area, only the print area is printed. 
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Print titles 
Row or column labels that are printed at the top of or on the left side of every page on a 
printed worksheet. 

Property fields 
Independent attributes associated with items, or members, in an OLAP cube. For example, if 
city items have size and population properties stored in the server cube, a PivotTable report 
can display the size and population of each city. 

Protect 
To make settings for a worksheet or workbook that prevent users from viewing or gaining 
access to the specified worksheet or workbook elements. 

Report filter 
A field that is used to filter a subset of data in a PivotTable or PivotChart report into one 
page for further layout and analysis. You can either display a summary of all items in a report 
filter, or display one item at a time, which filters out the data for all other items. 

Query 
In Query or Access, a means of finding the records that answer a particular question you ask 
about the data stored in a database. 

Query channel 
You use a query channel in a DDE conversation between the destination application and a 
specific query (for example, Query1) in Query. To use a query channel, you must have 
already opened the query window using a system channel. 

Query design 
All elements included in the Query window, such as tables, criteria, the order in which fields 
are arranged, and so on. The design also specifies whether Auto Query is turned on, and 
whether you can edit the source data. 

Range 
Two or more cells on a sheet. The cells in a range can be adjacent or nonadjacent. 

Read-only 
A setting that allows a file to be read or copied but not changed or saved. 

Record 
A collection of information about a particular person, place, event, or thing. When Query 
displays a result set in the Data pane, a record is represented as a row. 

Refresh (external data range) 
To update data from an external data source. Each time you refresh data, you see the most 
recent version of the information in the database, including any changes that were made to 
the data. 

Refresh (PivotTable report) 
To update the contents of a PivotTable or PivotChart report to reflect changes to the 
underlying source data. If the report is based on external data, refreshing runs the 
underlying query to retrieve new or changed data. 
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Regression analysis 
A form of statistical analysis used for forecasting. Regression analysis estimates the 
relationship between variables so that a given variable can be predicted from one or more 
other variables. 

Relative reference 
In a formula, the address of a cell based on the relative position of the cell that contains the 
formula and the cell referred to. If you copy the formula, the reference automatically 
adjusts. A relative reference takes the form A1. 

Remote reference 
A reference to data stored in a document from another program. 

Report template 
An Excel template (.xlt file) that includes one or more queries or PivotTable reports that are 
based on external data. When you save a report template, Excel saves the query definition 
but does not store the queried data in the template. 

Result set 
The set of records returned when you run a query. You can see the result set of a query in 
Query, or you can return a result set to an Excel worksheet for further analysis. 

Row heading 
The numbered gray area to the left of each row. Click the row heading to select an entire 
row. To increase or decrease the height of a row, drag the line below the row heading. 

Row label 
A field that is assigned a row orientation in a PivotTable report.  

Scenario 
A named set of input values that you can substitute in a worksheet model. 

Scroll lock 
With scroll lock turned on, the arrow keys scroll the active sheet rather than make a 
different cell active. To turn scroll lock off or on, press the SCROLL LOCK key. 

Section 
Any combination of a worksheet, view, and scenario that you choose when you create a 
report. A report can contain several sections. 

Select 
To highlight a cell or range of cells on a worksheet. The selected cells will be affected by the 
next command or action. 

Select All button 
The gray rectangle in the upper-left corner of a datasheet where the row and column 
headings meet. Click this button to select all cells on a datasheet. 

Series axis 
A chart axis that represents the depth dimension in a true 3-D chart. It displays the series 
names as arbitrary text values; it cannot display scaled numerical values. 

Series field 
A field that is displayed in the series area of a PivotChart report. Items in a series field are 
listed in the legend and provide the names of the individual data series. 
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Series lines 
In 2-D stacked bar and column charts, lines that connect the data markers in each data series 
that are used to emphasise the difference in measurement between each series. 

Shared workbook 
A workbook set up to allow multiple users on a network to view and make changes at the 
same time. Each user who saves the workbook sees the changes made by other users. 

Sort order 
A way to arrange data based on value or data type. You can sort data alphabetically, 
numerically, or by date. Sort orders use an ascending (1 to 9, A to Z) or descending (9 to 1, Z 
to A) order. 

Source areas 
The cell ranges that you consolidate in the destination area you specify. Source areas can be 
on any worksheet in a workbook, in other open or closed workbooks, or on Lotus 1-2-3 
worksheets. 

Source data 
The list or table that is used to create a PivotTable or PivotChart report. Source data can be 
taken from an Excel table or range, an external database or cube, or another PivotTable 
report. 

SQL 
A language used to retrieve, update, and manage data. When you create a query, Query 
uses SQL to build the corresponding SQL SELECT statement. If you know SQL, you can view or 
change the SQL SELECT statement. 

Standard font 
The default text font for worksheets. The standard font determines the default font for the 
Normal cell style. 

Summary data 
For automatic subtotals and worksheet outlines, all rows or columns that summarise detail 
data. Summary data usually is adjacent to and below the detail data. 

Summary function 
A type of calculation that combines source data in a PivotTable report or a consolidation 
table, or when you are inserting automatic subtotals in a list or database. Examples of 
summary functions include Sum, Count, and Average. 

System channel 
Used in a DDE conversation between applications to get information about the system, such 
as the current connections, open queries, and the status of the destination application. 

Table pane 
The area of the Query window that displays the tables in a query. Each table displays the 
fields from which you can retrieve data. 

Template 
A workbook that you create and use as the basis for other similar workbooks. You can create 
templates for workbooks and worksheets. The default template for workbooks is called 
Book.xlt. The default template for worksheets is called Sheet.xlt. 
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Text box 
A rectangular object on a worksheet or chart, in which you can type text. 

Tick marks and tick-mark labels 
Tick marks are small lines of measurement, similar to divisions on a ruler, that intersect an 
axis. Tick-mark labels identify the categories, values, or series in the chart. 

Titles in charts 
Descriptive text that is automatically aligned to an axis or centred at the top of a chart. 

Total row 
A special row in an Excel table that provides a selection of aggregate functions useful for 
working with numerical data. 

Totals 
One of the five calculation types Query defines for you: Sum, Avg, Count, Min, and Max. 

Trend line 
A graphic representation of trends in data series, such as a line sloping upward to represent 
increased sales over a period of months. Trendlines are used for the study of problems of 
prediction, also called regression analysis. 

Trend line label 
Optional text for a trendline, including either the regression equation or the R-squared 
value, or both. A trendline label can be formatted and moved; it cannot be sized. 

Up-down bars 
In line charts with multiple data series, bars that indicate the difference between data points 
in the first and last series. 

Value 
The text, date, number, or logical input that completes a condition that a field must meet for 
searching or filtering. For example, the field Author with the condition <b>equals</b> must 
include a value, such as <b>John</b>, to be complete. 

Value axis 
A chart axis that displays scaled numerical values. 

Value field 
A field from a source list, table, or database that contains data that is summarised in a 
PivotTable report or PivotChart report. A value field usually contains numeric data, such as 
statistics or sales amounts. 

Values area 
The part of a PivotTable report that contains summary data. Values in each cell of the values 
area represent a summary of data from the source records or rows. 

Vertexes 
Black, square, drag gable points that appear at the ends and intersections of lines or curves 
in certain AutoShapes (such as free forms, scribbles, and curves) when you edit points on the 
AutoShape. 
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View 
A set of display and print settings that you can name and apply to a workbook. You can 
create more than one view of the same workbook without saving separate copies of the 
workbook. 

Web query 
A query that retrieves data stored on your intranet or the Internet. 

What-if analysis 
A process of changing the values in cells to see how those changes affect the outcome of 
formulas on the worksheet. For example, varying the interest rate that is used in an 
amortisation table to determine the amount of the payments. 

Workbook 
A Spreadsheet program file that you create in Excel. A workbook contains worksheets of 
rows and columns in which you can enter and calculate data. 

Worksheet 
The primary document that you use in Excel to store and work with data. Also called a 
spreadsheet. A worksheet consists of cells that are organised into columns and rows; a 
worksheet is always stored in a workbook. 

Workspace file 
A file that saves display information about open workbooks, so that you can later resume 
work with the same window sizes, print areas, screen magnification, and display settings. A 
workspace file does not contain the workbooks themselves. 

World Wide Web 
A system for navigating the Internet or through a collection of workbooks and other Office 
documents connected by hyperlinks and located on a network share, a company intranet or 
the Internet. When you use a Web browser, the Web appears as a collection of text, 
pictures, sounds, and digital movies. 

Wrap 
In text, to break a line of text automatically on reaching a margin or object and continue the 
text on a new line. 

XML 
Extensible Markup Language (XML): A condensed form of Standard Generalised Markup 
Language (SGML) that enables developers to create customised tags that offer flexibility in 
organising and presenting information. 
 
 



 

 

FODE SUBJECTS AND COURSE PROGRAMMES 

GRADE LEVELS SUBJECTS/COURSES 

Grades 7 and 8 

1. English 

2. Mathematics 

3. Personal Development  

4. Social Science 

5. Science 

6. Making a Living 

Grades 9 and 10 

1. English 

2. Mathematics 

3. Personal Development  

4. Science 

5. Social Science 

6. Business Studies 

7. Design and Technology- Computing 

Grades 11 and 12 

1. English – Applied English/Language& Literature  

2. Mathematics - Mathematics A / Mathematics B 

3. Science – Biology/Chemistry/Physics 

4. Social Science – History/Geography/Economics 

5. Personal Development 

6. Business Studies 

7. Information & Communication Technology 

 
 
 
 
 
 
 
 

GRADES 11 & 12 COURSE PROGRAMMES 

Notes: You must seek advice from your Provincial Coordinator regarding the recommended 
courses in each stream. Options should be discussed carefully before choosing the stream when 
enrolling into Grade 11.  FODE will certify for the successful completion of seven subjects in Grade 
12. 

 

 

No Science Humanities Business 

1 Applied English Language & Literature Language & Literature/Applied English 

2 Mathematics A/B Mathematics A/B Mathematics A/B 

3 Personal Development Personal Development Personal Development 

4 Biology Biology/Physics/Chemistry Biology/Physics/Chemistry 

5 Chemistry/ Physics Geography Economics/Geography/History 

6 Geography/History/Economics History / Economics  Business Studies 

7 ICT ICT ICT   

CERTIFICATE IN MATRICULATION STUDIES 

No Compulsory Courses Optional Courses 

1 English 1 Science Stream: Biology, Chemistry, Physics    

2 English 2 Social Science Stream: Geography, Intro to Economics and Asia 
and the Modern World 

3 Mathematics 1  

4 Mathematics 2  

5 History of Science & Technology  

REMEMBER: 

 For Grades 7 and 8, you are required to do all six (6) subjects. 

 For Grades 9 and 10, you must complete five (5) subjects and one (1) optional to be certified. Business Studies 
and Design & Technology – Computing are optional.  

 For Grades 11 and 12, you are required to complete seven (7) out of thirteen (13) subjects to be certified. 
Your Provincial Coordinator or Supervisor will give you more information regarding each subject and course. 

 

REMEMBER: You must successfully complete 8 courses: 5 compulsory and 3 optional. 
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CUG 

PHONE 

1 DARU P. O. Box 68, Daru 6459033  72228146 The 
Coordinator 

Senior 
Clerk 

72229047 

2 KEREMA P. O. Box 86, Kerema 6481303  72228124 The 
Coordinator 

Senior 
Clerk 

72229049 

3 CENTRAL C/- FODE HQ 3419228 72228110 The 
Coordinator 

Senior 
Clerk 

72229050 

4 ALOTAU P. O. Box 822, Alotau 6411343 / 6419195 72228130 The 
Coordinator 

Senior 
Clerk 

72229051 

5 POPONDETTA P. O. Box 71, 
Popondetta 

6297160 / 6297678  72228138 The 
Coordinator 

Senior 
Clerk 

72229052 

6 MENDI P. O. Box 237, Mendi 5491264 / 
72895095 

72228142 The 
Coordinator 

Senior 
Clerk 

72229053 

7 GOROKA P. O. Box 990, Goroka 5322085 / 5322321 72228116 The 
Coordinator 

Senior 
Clerk 

72229054 

8 KUNDIAWA P. O. Box 95, 
Kundiawa 

5351612  72228144 The 
Coordinator 

Senior 
Clerk 

72229056 

9 MT HAGEN P. O. Box 418, Mt. 
Hagen 

5421194 / 5423332 72228148 The 
Coordinator 

Senior 
Clerk 

72229057 

10 VANIMO P. O. Box 38, Vanimo 4571175 / 4571438 72228140 The 
Coordinator 

Senior 
Clerk 

72229060 

11 WEWAK P. O. Box 583, Wewak 4562231/ 4561114 72228122 The 
Coordinator 

Senior 
Clerk 

72229062 

12 MADANG P. O. Box 2071, 
Madang 

4222418 72228126 The 
Coordinator 

Senior 
Clerk 

72229063 

13 LAE P. O. Box 4969, Lae 4725508 / 4721162  72228132 The 
Coordinator 

Senior 
Clerk 

72229064 

14 KIMBE P. O. Box 328, Kimbe 9835110 72228150 The 
Coordinator 

Senior 
Clerk 

72229065 

15 RABAUL P. O. Box 83, Kokopo 9400314  72228118 The 
Coordinator 

Senior 
Clerk 

72229067 

16 KAVIENG P. O. Box 284, Kavieng 9842183 72228136 The 
Coordinator 

Senior 
Clerk 

72229069 

17 BUKA P. O. Box 154, Buka 9739838 72228108 The 
Coordinator 

Senior 
Clerk 

72229073 

18 MANUS P. O. Box 41, 
Lorengau 

9709251 72228128 The 
Coordinator 

Senior 
Clerk 

72229080 

19 NCD C/- FODE HQ 3230299 Ext 26 72228134 The 
Coordinator 

Senior 
Clerk 

72229081 

20 WABAG P. O. Box 259, Wabag 5471114  72228120 The 
Coordinator 

Senior 
Clerk 

72229082 

21 HELA P. O. Box 63, Tari 73197115 72228141 The 
Coordinator 

Senior 
Clerk 

72229083 

22 JIWAKA c/- FODE Hagen  72228143 The 
Coordinator 

Senior 
Clerk 

72229085 

 
 

 


